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Your success is important to us!

SMS 5.0 introduces a full-featured report writer that creates attractive,
customized reports for scorecards, initiatives, and datasets. It also has a brand-
new chart designer with powerful display options like predictive analytics and
reference lines & bands. There are 8 new infographic widgets for your
dashboards, including process charts, waffle charts, funnels, pyramids, and

filled containers.

SMS is powered by commercial off-the-shelf software from Spider Strategies
called Spider Impact. Their online knowledge base will be updated with all of the
latest version 5 information on October 20, 2021 at
https://support.spiderstrategies.com/hc/en-us/categories/360002648452-
Using-Spider-Impact

For more information on SMS and Army-specific support resources, please visit

https://www.milsuite.mil/book/community/spaces/orion/sms

If you have any questions, we're available to help at 703-607-5014 or

usarmy.pentagon.hgda-osa-obt.mbx.sms@mail.mil
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Charts

The Charts section

Charts are significantly more powerful in SMS 5. Because of this, charts now

have their own application section that is separate from Reports.

@ Mobileworld Inc. Scorecard Chart © % A B ©

View Edit June2021 v < >

+ New Chart O New Folder

(5 Scorecard Chart

mple o °
al Example ¢ \ / i /

0—yg

0—0—o o

Admin: Advanced Permissions Select default Unselect all

O viEW [E] cHARTS AND REPORTS *ss OTHER

View All Organizations Modify Charts and Reports Modify Scorecard and Initiative Notes

Modify Baokmarks and Personal Settings Modify SQL Cansole Reports Modify Related Items

Change Personal Profile
10 eRIEFINGS Z% ADMINISTRATION

o UPDATE KPIS Modify Briefings Create + Edit Users in Groups They Administer

Update All Viewable KPI Values Delete Users in Groups They Administer
(0 DATASETS

Update All Viewable Scoring Threshold Values Log In As Other Users
Modify All Datasets

Modify View Organization Permissions

INITIATIVES Modify Standard Permission Datasets

Modify All Scheduled Exports
Edit Initiatives Modify Standard Permission Dataset Records

_ _ Madify All Imports
Update Initiative Status View Standard Permission Dataset Records

Modify Import Connections
Archive Initiatives Modify Standard Permission Dataset Views

Cancel

Creating a chart

To create a chart, click the "New Chart" button.
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[0 Mobileworld Inc. Seasonal Example

View

Name

Seasonal Example

@ Copy

Tr Delete

i a ©

Edit July2021 + < >

From here you can name your new chart and decide what it should look like. The

default chart type is Blank, but you can choose from a wide variety of example

charts to get you started.

D Mobileworld Inc. Example

Example Chart

View

Name

Example Chart

Starting Layout

Scorecard
Line

—r

Multiple Lines

¥Z Expand All

A

Scorecard
Light Bands

Dual Axis

A

Scorecard
Dark Bands

I

Multiple Bar

Ay

1
il

Stacked Bar

e

Edit

Il L

Stacked 100% Stacked
Bar Multiple Bar Stacked Area
A‘IJ%
Cancel

If you choose a pre-built chart example, you'll see a fully finished version of your

chart with sample data. This allows you to build visualizations based on how

they look rather than focusing on getting the data exactly right from the

beginning. All sample data series are marked blue.
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LEFTAXIS # REPEAT /' RIGHT AXIS /' OTHER /'

Sample Data 1 Calendar Period Bar Color
5 Periods Earlier-Current Period Manual Colors
XandY Axes
All Labels, Auto Range
Data Table
Hidden
100
80
60
40
20
0
Feb Mar Apr May Jun Jul
2021 2021 2021 2021 2021 2021

Editing chart data

Whenever you're ready to see your own data on the chart, just edit the data
source on a sample data series. In this example there's a sample bar series on

the left axis, so we'll click on it and choose "Set Data Source”.

LEFT AXIS REPEAT /' RIGHT AXIS /#° OTHER /'
+ Add Data + Add Analytics Calendar Period Bar Color
mAste e et Period Manual Colors
I Sample Data 1 ||l = EcitiataiSenes Xand Y Axes
All Labels, Auto Range
Set Name

Data Table
Set Data Source 0 Hidden
Color ® >

100
ChartType 1. »
80 T Delete
60
40
20
0
Feb Mar Apr May Jun Jul
2021 2021 2021 2021 2021 2021
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This allows you to choose to show any type of data from scorecard items,
initiative items, or dataset fields. We'll choose to show the KPI Value for

Product Revenue.

Set Data Source

Item Type

Scorecard Initiative Dataset

Type

Basic Calculated

Scorecard Item

Product Revenue

Field

KPI Value

Cancel

Now our chart is showing real data. All that's changed is the height of the bars.

WHAT'S NEW IN 5.0 8



LEFTAXIS /' REPEAT /' RIGHT AXIS /' OTHER /'

Product Revenue Calendar Period Bar Color
5 Periods Earlier-Current Period Manual Colors

Apr May

Xand Y Axes
All Labels, Auto Range

Data Table
Hidden

$600K

$500K

$400K

$300K

$200K

$100K

$0

Feb Mar
2021 2021 2021 2021 2021 2021

Jun Jul

Adding chart data

You can also add data series to your chart one at a time by clicking the “Add
Data"” button. Some chart types will ask what kind of data series you want. In

this example the options are a new Line, Bar, or Area data series. We'll choose

Bar.

LEFT AXIS EAT /' RIGHT AXIS / oTi
+ Add Data Add Analytics Calendar Period Ba
5 Periods Earlier-Current Period Ma
l Pr Add Data Series |, = Xa
All

°s* Line >
Da
Il Bar & > Hic

= Area >

$600K

Next, choose where in SMS to get your data. You can choose a scorecard item
like a KPI, an initiative, or low-level data from a dataset. We'll choose Scorecard

[tem.

WHAT'S NEW IN 5.0 9



LEFT AXIS
+ Add Data + Add Analytics
I pr € Bar ‘ =

@ Dataset >
$600K

REPEAT

Calendar Period

5 Periods Earlier-Current Period

3 Sscorecard Ite% > ‘
= Initiative >

RIGHTAXIS /' OTH

Bar
Mar

Xar
All L

Dat:
Hid

dranv - - - - -

From here you can add bars directly to the chart. Every time you click the add

button, it adds a bar for that scorecard item.

LEFT AXIS

<+ Add Data <+ Add Analytics

lPr<

@ Mobileworld Inc.

REPEAT /'

Calendar Period

5 Perinds Farlier-Current Perind

Scorecard Item

[:2] Mobileworld Scorecard

@ Key Performance Indicators v A Financial
$600I @ Financial v @ Increase Revenue

@® Marketing & Product Revenue
$5001

@ Customer Support & Training Revenue
$400l ® sales & Book Revenue

@ Operations © Total Revenue
$300!

@ Information Technology > @ Improve Profitability
$2001 -

¥=< ExpandAll ¥=< ExpandAll

$100K I [— e

RIGHTAXIS /' oTt

Bai
Ma

Xa
All

Dai

Add

After two clicks of the Add button, we have a chart that looks like this.
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LEFTAXIS /' REPEAT /' RIGHT AXIS /' OTHER /'

Product Revenue Calendar Period Bar Color
. 5 Periods Earlier-Current Period Manual Colors
Training Revenue
XandY Axes
Book Revenue All Labels, Auto Range
Data Table
Hidden
$600K
$500K
$400K
$300K
$200K
$100K
- ] i | [ [
Feb Mar Apr Ma; Jun
2021 2021 2021 2021 2021 2021

Right axis
Adding data to the right axis is exactly the same process. Here we'll add a line

for a scorecard item's score.

LEFTAXIS /' REPEAT /' RIGHT AXIS OTHER /
Product Revenue Calendar Period + Add Data + Add Analytics Bar Color
5 & Perinds Farlier—Current Perind Manual Colors
Train
< Scorecard Item X and Y Axes
Book cha ta above All Labels, Manual Range
Data Table
Hidden
@ Mobileworld Inc. [z] Mobileworld Scorecard

@ Key Performance Indicators > A Financial Adv.litd

@ Financial > A Customer
$600K

@ Marketing » A Internal Processes
$500K @ Customer Support > A Organizational Capacity

® Sales
$400K

@ Operations
£30oy @ Information Technology
$200K

¥3 Expand All Y= Expand All

sooc [N I | I |

This 0-10 score line is now showing on the right axis while the three bars'

$100k+ Revenue are graphed on the left axis.
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LEFTAXIS /# REPEAT / RIGHT AXIS / OTHER #

Product Revenue Calendar Period Financial Bar Color
- 5 Periods Earlier-Current Period Manual Colors
Training Revenue
Line Color
Book Revenue Manual Colors
X and Y Axes

All Labels, Manual Range

Data Table
Hidden
ﬁ 10
$600K
e,
()
$500K g
$400K > L . 6
$300K
4
$200K
2
$100K
- B I | [ I B ,
Feb Mar Apr May Jun Jul
2021 2021 2021 2021 2021 2021

Reordering with drag and drop
You can reorder anything on your chart by dragging and dropping. In this

example, the Training Revenue bar comes before the Product Revenue bar.

LEFT AXIS EPEAT /' RIGHT AXIS THER /'
+ Add Data + Add Analytics ~ Calendar Period + Add Data + Add Analytics ~ 3arColors
2 Periods Earlier-Current Period Manual Colors
l Book Revenue L You can drag it here -ine & Point Colors
Vanual Colors
l Training Revenue @ |i % « X and Y Axes
All Labels, Auto Range
' Product Revenue || |
Data Table
Hidden
$500K
$450K
$400K
$350K
$300K
$250K
$200K
$150K
$100K
$50K
$0
Jun Jul Aug
2021 2021 2021
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After moving Training Revenue to the bottom of the list, its bar is now on the

right.

LEFT AXIS

+ Add Data + Add Analytics

l Book Revenue
I Product Revenue

I Training Revenue (W]

$500K
$450K
$400K
$350K
$300K

$250

$200K

$150K

$100K

$50K

EPEAT /'

Zalendar Period
2 Periods Earlier-Current Period

“K

Jun
2021

i ks

RIGHT AXIS /° OTHER /'
Bar Colors
Manual Colors

Line & Point Colors
Manual Colors

Xand Y Axes
All Labels, Auto Range

Data Table
Hidden

Jul Aug
2021 2021

The order also affects the order above and below other items. Here we've

moved the Book Revenue line to the bottom so that it's underneath the bars.

LEFT AXIS

+ Add Data + Add Analytics

I Product Revenue
I Training Revenue

l Book Revenue @

$500K

$450K

$350K
$300K
$250K
$200K
$150K
$100K

$50K

$o0

WHAT'S NEW IN 5.0
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Jun
2021

m

EPEAT /'

Zalendar Period
2 Periods Earlier-Current Period

okl

RIGHTAXIS /' OTHER /'
Bar Colors
Manual Colors

Line & Point Colors
Manual Colors

Xand Y Axes
All Labels, Auto Range

Jul Aug

2021 2021

Data Table
Hidden




You can even drag items to the other axis. Here we've moved Book Revenue to

the right axis so that it has its own scale.

LEFT AXIS

+ Add Data

I Product Revenue
l Training Revenue

You can drag it here

$500K

Jun
2021

+ Add Analytics

EPEAT /

Calendar Period

RIGHT AXIS

+ Add Data

2 Periods Earlier-Current Period

Book wae

L]
e $28.5K
$400K
$28K
$350K
aton $27.5K
$250K 527K
S200K $26.5K
$150K
526K
$100K
H $25.5K
ssoK I -
$0 $25K

Jul
2021

Setting data series names

JTHER /'

3ar Colors
vanual Colors

-ine & Point Colors
vanual Colors

XandY Axes
All Labels, Auto Range

Data Table
Hidden

$29K

Aug
2021

Data series names are used in various places like chart labels, tooltips, and

legends. SMS chooses a default name for each data series, but you can override

this by choosing Set Name in the edit tooltip.

LEFT AXIS
+ Add Data + Add Analytics
I Product Revenue W ||

l Training Revenue

l Book Revenue

$600K

$500K

WHAT'S NEW IN 5.0

l Tir  Delete

REPEAT /

Calendar Period

" nt Period
Edit Data Series

Set Name
Set Data Source

Color

e >

ChartType 1], »

RIGHTAXIS /'



Here we've decided to change the Product Revenue scorecard item's name on

the chart to All Revenue.

Set Name

NAME TYPE Default

Data Series Name

All Revenue

Cancel

This new name is now used everywhere for that data series.
LEFTAXIS /' REPEAT /' RIGHT AXIS /'

All Revenue Calendar Period

. 5 Periods Earlier-Current Period
Training Revenue

Book Revenue

Setting colors

By default, chart data series use automatically assigned colors. You can also

choose to manually change any automatically assigned color.

WHAT'S NEW IN 5.0 15



LEFT AXIS REPEAT /'

+ AddData + Add Analytics Calendar Period
T t Period
l All Revenue i = < Color
l Training Revenue I, = o0 [ X
@0 00
l Book Revenue i = . . . .
(N N
0 " 00
$600K
(| e

You can choose a different way to color the data series, however. In this

example we're going to click on Bar Colors in the Other panel.

3

RIGHT AXIS / OTHER

Bar Colors
ent Period Manual Colors {‘@

XandY Axes
All Labels, Manual Range

Data Table
Hidden

And we'll change from Manual to Score.

Set Bar Colors

BAR COLORS Manual Colors Score Colors Specific Color

Cancel

WHAT'S NEW IN 5.0
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+ Add




This changes the bars to be colored based on each scorecard item'’s score for

that period.

LEFTAXIS /" REPEAT /'

Calendar Period
5 Periods Earlier-Current Period

All Revenue
Training Revenue

Book Revenue

$600K

$500K

$400K

$300K

$200K

$100K

Sep Oct Nov
2021 2021 2021

==

RIGHT AXIS /' OTHER /'
Bar Color
Score Colors
Xand Y Axes
All Labels, Manual Range
Data Table
Hidden

Dec Jan Feb

2021 2022 2022

You can also force all the bars for all data series to a single color by choosing

Specific Color. This is the same as manually setting all data series to the same

color individually.

Set Bar Colors

BAR COLORS Manual Colors

Cancel

WHAT'S NEW IN 5.0
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LEFTAXIS / REPEAT /' RIGHT AXIS /" OTHER /'

All Revenue Calendar Period Bar Colors
5 Periods Earlier-Current Period Specific Color
Training Revenue
XandY Axes
[P All Labels, Manual Range
Data Table
Hidden
$600K
$500K
$400K
$300K
$200K
$100K
% B [ | (| [ | |
Sep Oct Nov Dec Jan Feb
2021 2021 2021 2021 2022 2022

X and Y axes

You can configure a chart's axes through the X and Y Axes box in the Other

panel.
LEFTAXIS /' REPEAT /' RIGHTAXIS /' OTHER
Financial Calendar Period Bar Color
11 Months Earlier-Current Month Score Colors
Bar Labels
Edit Axes XandY Axes
All Labels, Auto Range @
X Axis Labels a
9 Data Table
. Y Axis Labels @ | MHidden
7 Set Y Axis Range
6
5
4
3
2
1
Jul Aug Sep Oct Nov Dec Jan Feb Mar Apr May Jun
2020 2020 2020 2020 2020 2020 2021 2021 2021 2021 2021 2021

The X and Y axis labels default to on, but you can turn one or both off here.

WHAT'S NEW IN 5.0



You can also set the Y axis range.

Jul Au
2020 202'0 zsa.z%

Oct
2020

Nov
2020

e~

Dec
2020

Jan
2021

XandY Axes
No Labels, Auto Range

All Labels, Auto Range

Edit Axes
X Axis Labels )0
C@ ta Table
Y Axis Labels en
Set Y Axis Range \
Edit Axes XandY Axes
X Axis Labels [ @)
Data Table
Y Axis Labels @  MHidden

Set Y Axis Range &

2021

Mar
2021

Apr May
2021 2021

Jun
2021

This opens a dialog where you can choose the chart's maximum and minimum Y

axis values. By default, they're automatically set, but here we're overriding the

maximum value to 50.
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Set Y axis range

Cancel

As you can see, the chart now shows a maximum value of 50, regardless of

what data is being graphed.

30
20

10

Edit Axes
X Axis Labels
Y Axis Labels

Set Y Axis Range

XandY Axes
All Labels, Manual Range

Data Table
Hidden

| [ ]

1 B B B N

Jul Aug Sep Oct Nov
2020 2020 2020 2020 2020

Chart labels

Dec
2020

Apr May Jun
2021 2021 2021

Most chart types have labels that you can configure. In this pie chart example,

you can see a Pie Slice Labels option in the Other menu.
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DATA / REPEAT OTHER

Financial Calendar Period Pie Slice Color
Current Period-Current Period Manual Colors
Customer

Internal Processes Pie Slice Labels Q&
Data Series Names, Charted Values

Pie Labels
None

Data Table
Hidden

Internal Processes
4.7 D

M __Financial
7.8

Customer /-

When we click it, we can see the various label options, including the ability to

show percentages and abbreviated chart values.

Edit Pie Slice Labels

+/ Data Series Names
Percentages
+/ Charted Values

Abbreviate Charted Values

Default Decimal Precision

Cancel
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Repeating left & right axes

When you're graphing scorecard items, you'll always be able to set your
calendar period range in the Repeat panel. Here we're showing 6 periods of
data for three KPIs. We can edit the calendar period range by clicking on it and
choosing “Edit Range”.

By Calendar Period Manual Colors

Training Revenue

+ Add Range X and Y Axes

Book Revenue All Labels, Auto Range
Current Calendar Edit Range Data Table
5 Periods Earlier-Current Period R .
Hidden
Edit Range ?
$600K 15 Delete

$500K
$400K
$300K
$200K
$100K
" B - N - B = - . P

Sep
2021 2021 2021 2021 2022 2022

This is the standard date range selector where you can choose either a range
based on the current calendar, or choose a specific calendar and choose a

relative or date range.

Edit Range

Range Type

Standard Date Range Group Similar Date Ranges

CALENDAR Current Calendar ~

5 Periods Earlier ~ TO Current Period ~
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You can even show data for multiple ranges. Here we're showing the data for

the current month as well as the data for the month one year earlier.

LEFTAXIS /' REPEAT RIGHTAXIS /
Product Revenue Repeating Left Axis
By Calendar Period L3
Training Revenue
Book Revenue + AddRange
Monthly

Current Month-Current Month rmmmmm——

Monthly
12 Months Earlier-12 Months Earlier

Aug
2021

OTHER /'

Bar Color
Manual Colors

Xand Y Axes
All Labels, Auto Range

Data Table
Hidden

—
$600K
$500K
$400K
$300K
$200K
$100K
I I
$0 pees

2020

While scorecard items have a built-in repeating by calendar period, datasets

and initiatives do not. In this dataset example, we have a single bar showing the

total sales dollars for all time.

LEFTAXIS /#° REPEAT /' RIGHT AXIS /#

Sale Price Sum

$45,000,000
$40,000,000
$35,000,000
$30,000,000
$25,000,000
$20,000,000
$15,000,000
$10,000,000

$5,000,000
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OTHER /'

Bar Color Manual Colors

Bar Labels

XandY Axes All Labels, Auto Range

Data Table Hidden
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Repeating values aren't required for datasets, but they are very useful. Here
we're going to the Repeat panel and choosing to repeat by the Sales Employee
field.

Choose A Field
I Sales Employee - ]
LEFTAXIS /' IGHTAXIS /' OTHER /'
More Options Repeat
Sale Price Sum Bar Color Manual Colors

gar Labels

XandYAxes All Labels, Auto Range

Data Table Hidden

$45,000,000

w’m'm _

We now have a separate bar showing the all-time sales totals for every
employee. Whenever the dataset is updated to include new employees, they'll

automatically show up in this chart.

LEFTAXIS /' REPEAT RIGHT AXIS /' OTHER /'
Sale Price Sum Repeating Left Axis Bar Color Manual Colors
By Every Sales Employee /s
Bar Labels

Delphine Calmes = Xand Y Axes All Labels, Auto Range

Edmond Zehrbach = Data Table Hidden
Hollie Pennigton =
b Issac Bernhardt H
¥,000,000  Kym Lavender = f
$8,000,000 Micheline Turkasz =
$7,000,000 Odell Sheler =
$6,000,000 Russell Corrick =
$5,000,000 Repeat again by...
$4,000,000
43,000,000
$2,000,000
$1,000,000
s0

Delphine Calmes  Edmond Zehrbach  Hollie Pennigton Issac Bernhardt Odell Sheler Russell Corrick
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Repeating again
You can choose to repeat your data series a second time. To do this, click on the

"Repeat again by..." button and choose a field. Here we're going to choose Sale
Date.

LEFTAXIS /' REPEAT RIGHTAXIS /" OTHER /'
Sale Price Sum Repeating Left Axis Bar Color Manual Colors
By Every Sales Employee /s o
Bar Labels

Delphine Calmes

Xand Y Axes All Labels, Auto Range

Edmond Zehrbach g Data Table Hidden
Hollie Pennigton - |
$10,000,000 Issac Bernhardt - |

$9,000,000 Kym Lavender

18,000,000 Choose A Field

$7,000,000 I sale Date |

$6,000,000 More Options

$5,000,000 Repeat again by

$4,000,000

$3,000,000

$2,000,000

$1,000,000

¥ Odell Sheler Russell Corrick

The chart is now showing the sales totals for the last two months for all

employees.

LEFTAXIS /' REPEAT / RIGHT AXIS #* OTHER /'
Sale Price Sum Every Sales Employee Bar Color Manual Colors
Sale Date Bar Labels
1 Month Earlier-Current Month XandV Axes All Labels, Auto Range
Data Table Hidden
June 2021 July 2021
$180,000 Russell Corrick H
5155.580 51
$160,000 - I
$140,000
$120,000
$100,000
$80,000
$60,000
$40,000
- I I
50
Delphine Calmes Hollie Pennigton ~ Kym Lavender  Odell Sheler Delphine Calmes Hollie Pennigton Odell Sheler
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Repeating non-axis charts

Repeating works the same for non-axis charts. In this example we're repeating
three KPIs for four calendar periods. By default, each calendar period is its own
pie chart, but you can change this by clicking on the calendar period range and

choosing “Edit Range”.

DATA /' REPEAT OTHER /'
Financial Repeating Data Pie Slice Colors

By Calendar Period Manual Colors
Customer

Pie Slice Labels
Add Range

Internal Processes + L Data Series Names, Charted Values

Current Calendar Edit Range

3 Periods Earlier-Current Period
Edit Range

&

1 Delete

Internal Processes
5.62

Financial

Financial Internal Processes 6.18

6.68 6.81

Customer
7.14

Customer
729

Financial
5.7 Internal Processes

6.02

Financial
577

Internal Processes
6.54

Customer
5.71

For non-axis charts there's a "“Treat Range As" toggle, allowing you to show one

chart for the entire range.
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The resultis

DATA /'

Financial
Customer

Internal Processes

WHAT'S NEW IN 5.0

Edit Range

Range Type

Standard Date Range Group Similar Date Ranges

CALENDAR Current Calendar ~
SHOW 3 Periods Earlier ¥ TO Current Period ~

TREAT RANGE AS Multiple Charts One Chart

this single pie chart that shows four periods of data.

REPEAT /' OTHER /'
Calendar Period Pie Slice Colors
3 Periods Earlier-Current Period Manual Colors

Pie Slice Labels
Data Series Names, Charted Values

Pie Labels
None

Data Table
Hidden

Financial
6.08

Internal Processes
6.25

Customer

== — n
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Grouping similar date ranges
In addition to graphing standard date ranges like all the months in 2021, you
can also graph data like months of the year or days of the week. In this example

we have two identical data series for Product Revenue, and we'll choose "Edit

n
Range”.
LEFTAXIS # REPEAT RIGHT AXIS # OTHER /"
Product Revenue Repeating Left Axis Bar Color
By Calendar Period Manual Colors
Product Revenue
+ AddRange Xand Y Axes
All Labels, Auto Range
Current Calendar @ Edit Range Data Table
5 Periods Earlier-Current Period Hidden
Edit Range h
$600K 17 Delete
$500K
$400K
$300K
$200K
$100K
50

Apr Aug

2021 2021 2021 2021 2021 2021

We'll change to "Group Similar Date Ranges” and then choose to group yearly

data by monthly.

Edit Range

Range Type

Standard Date Range Group Similar Date Ranges

GROUP Yearly ¥ DATABY  Monthly ~

Relative By Date

January ¥ TO December ~
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When we're done, we see a completely different kind of graph. As you can see, it
now lists the months across the X axis but no years. Our chart now shows
product revenue for the current year compared against product revenue for the

previous year.

LEFT AXIS REPEAT /' RIGHT AXIS /" OTHER /'
+ AddData + Add Analytics Calendar Period Bar Color
January - December Manual Colors
Product Revenu il, = Edit Data Series Xand Y Axes
Current Year @ 7l All Labels, Auto Range
Set Name
Product Revenue i, = :a;: Table
N = idaen
1'ear Earlier Set Data Source

$700K Set Period

$600K Color

Chart Type
$500K
1 Delete
$400|
$300K
$200K
$100K
0

Every scorecard data series has a "Set Period"” menu item. This only shows up

=

o

when you've chosen to “Group Similar Date Ranges” and it allows you to choose
which period to use for each data series. That's how we choose Product

Revenue for this year vs. last year.

Set Period

CHOOSE AYEAR

TYPE Relative By Date

SHOW Current Period ~

Cancel

WHAT'S NEW IN 5.0 29



There's no “Set Period” menu item for datasets. Instead, you can just choose

which date range you want as a filter in the "Set Data Source” menu.

Set Data Source

Item Type

Scorecard Initiative Dataset
Type
Basic Calculated

Dataset Go to Dataset

Customers ’

Field

Number of Customers

Decimal Precision

Default Decimal Precision

FILTERS <+ Add

Customers with Sales matching (Device Sale Date: between Current Period and Current Period

(Yearly))

Bar and area stacks

You can create bar or area stacks by choosing them from the “Add Analytics”

menu on either the left or right axis.

WHAT'S NEW IN 5.0 30



LEFT AXIS

<+ Add Data

l Product Revenue
I Training Revenue

l Book Revenue

$500K
$450
$400K
$350K
$300K
$250K
$200K
$150K
$100K
$50K

$0
Mar
2021

<+ Add Analytics

EPEAT /'

3 Perinde Farlier-Current Perind

SUMMARIZE
Bar Stack Area Stack
&
Minimum Line Goal Lines

TREND-LINE

oft
o
P

e

Trend Line

= Ml =
Apr

May

2021 2021

This adds an empty stack to the axis.

LEFT AXIS

<+ Add Data

l Product Revenue
l Training Revenue

l Book Revenue

@

Untitled Stack
Drag here to stack

$600K
$500K

$400!

$300K

$200K

$100K

Mar
2021
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+ Add Analytics

REPEAT #°

Calendar Period
5 Periods Earlier-Current Period

o;/

Apr

2021

May
2021

RIGHTAXIS /°

Add Analytics

Constant Line

Light Scoring
Bands

Jun
2021

RIGHT AXIS /"

Jun
2021

Average Line

Dark Scoring
Bands

Jul

2021

Jul
2021

OTHER /'

Bar Colors
Manual Colors

Maximum Line

o

Custom Lines
And Bands

OTHER /'

Bar Color
Manual Colors

Xand Y Axes
All Labels, Auto Range

Data Table
Hidden

Al.l‘
2021

mbers, ...
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All you need to do is drag and drop data series into the stack. Here we've added
book and training revenue to the stack while product revenue is its own bar. This

allows you to have multiple stacks and non-stacked bars at the same time.

LEFT AXIS REPEAT /° RIGHT AXIS OTHER /'
+ AddData + Add Analytics Calendar Period Bar Color
5 Periods Earlier-Current Period Manual Colors
l Product Revenue || E Xand Y Axes
All Labels, Auto Range
Untitled Stack i ® _ Data Table
Hidden
I Book Revenue 1 |
I Training Revenue il
$600K
$500K
$400K
$300K
$200K
$100K
$0
Mar Apr May Jun Jul Aug
2021 2021 2021 2021 2021 2021

You can configure the stack by clicking on it. By default, 100% height is off, and
you can see how the Y axis goes up to $1M.

LEFT AXIS REPEAT # RIGHT AXIS /' OTHER /'
+ Add Data + Add Analytics Calendar Period Bar Color
5 Periods Earlier-Current Period Manual Colors
Untitled Stack 5 @ = Edit Stack Xand Y Axes
All Labels, Auto Range
Set Label
l Product Revenue || 3 Data Table
Hidden
Chart Type >
I Book Revenue || YP i
. Set Sorting.
Training Revenue il
100% Height h
T Delete
$1M
$800K
$600K
$400K
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When we turn on the 100% Height toggle, the Y axis changes to percentages

and all repeating stacks become full height.

LEFT AXIS REPEAT /' RIGHTAXIS # OTHER /'
+ Add Data + Add Analytics Calendar Period Bar Color
5 Periods Earlier-Current Period Manual Colors
Untitled Stack i: @ = Edit Stack XandY Axes
All Labels, Auto Range
Set Label
I Product Revenue 1] E| Data Table
Hidden
Chart Type >
I Book Revenue 1 | . i
. Set Sorting
Training Revenue ] g
100% Height @)
1T Delete
100%
80%
60%
40%

You can also change between Bar and Area stacks.

LEFT AXIS REPEAT /' RIGHT AXIS /'
+ Add Data + Add Analytics Calendar Period
5 Periods Earlier-Current Period

Untitled Stack & i @O = <  ChartType

' it Bar
l Product Revenue || E

= Area
l Book Revenue || E
l Training Revenue || E

Trend lines

You can add a trend line from each axis' Add Analytics menu.
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LEFT AXIS y
+ Add Data + Add Analytics Calendar Period

12 Perinds Farlier-Current Parind

l Product Revenue

l Training Revenue SUMMARIZE
l Book Revenue l I
SERK Bar Stack Area Stack
$500K
$400K - -
Minimum Line Goal Lines
$300K
$200K TREND-LINE
$100K
e, ?
$0 A o
u K
L b Trend Line

RIGHT AXIS /'

Add Analytics

Constant Line

-
an

Scoring Bands

Average Line

—

Reference Lines

And Bands

OTHER /"

Bar Color
Manual Colors

Range
Maximum Line
Jul Aug
2021 2021

We now see a trend line object in the left axis panel. There's also a trend line

showing each month's average of the three series.

LEFT AXIS REPEAT /
+ Add Data + Add Analytics Calendar Period
12 Periods Earlier-Current Period
l Product Revenue il. =
l Training Revenue || E
l Book Revenue || E
Fill1
Line 1
Fill2

$300K

$200K

$100K

Aug Sep Oct Nov Dec Jan
2020 2020 2020 2020 2020 2021

You can change the line's color.
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RIGHT AXIS /'

Feb Mar
2021 2021

[
L

2021

OTHER /°

Bar Color
Manual Colors

Xand Y Axes
All Labels, Auto Range

Data Table

Hidden
May Jun Jul Aug
2021 2021 2021 2021
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LEFT AXIS REPEAT RIGHT AXIS /' OTHER /'

+ Add Data + Add Analytics Calendar Period Bar Color
12 Periods Earlier-Current Period Manual Colors
I Product Revenue il = XandY Axes

All Labels, Auto Range

I Training Revenue 1 |, =
Data Table
l Book Revenue i, = Jidcen
Fill1
Line1 & Edit Line
Fill2 SHOW LINE a
Set Label
$400K
Set Data Source
$300K Color >
$200K 1 Delete
- l l
50
Aug Sep Oct Nov Dec Jan Feb Mar Apr May Jun Jul Aug
2020 2020 2020 2020 2020 2021 2021 2021 2021 2021 2021 2021 2021

You can also set its data source. Here we're changing it to Product Revenue
rather than All Data.

Set Data Source

Line Data Source

All Data

All Data
Product Revenue
Training Revenue

Book Revenue

The chart now looks like this.
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$600K

AL

Sep Nov Dec Jan Feb Mar May Jun Jul
J.DID 2020 2{)20 2020 2020 2021 2021 2021 2021 2021 2021 2021

o

Trend lines have an optional fill above and below. Here we're filling red above

the yellow trend line.

LEFT AXIS REPEAT /' RIGHTAXIS /° OTHER /'
+ Add Data + Add Analytics Calendar Period Bar Color
12 Periods Earlier-Current Period Manual Colors
I Product Revenue il = XandY Axes
All Labels, Auto Range
l Training Revenue il =
Data Table
I Book Revenue i, = Hildden
Fill @ Edit Fill
Linel SHOW FILL a — =
Fill2 Set Label
Color ® >
$400K
$300K
$200K
$100K
$0
Aug Sep Oct Nov Dec Jan Feb Mar Apr May Jun Jul Aug
2020 2020 2020 2020 2020 2021 2021 2021 2021 2021 2021 2021 2021

Here we've turned off the display of the line and are showing a red fill above the

trend and a green fill below.
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LEFT AXIS REPEAT /' RIGHT AXIS /' OTHER /'

+ Add Data + Add Analytics Calendar Period Bar Color
12 Periods Earlier-Current Period Manual Colors
l Product Revenue || = Xand Y Axes
All Labels, Auto Range
l Training Revenue 1 I =
Data Table
l Book Revenue 1 l, = Riidcen
Fill1
Line1 @ Edit Line
Fill 2 SHOW LINE
Set Label
SARK Set Data Source
$300K Color >
17 Delete
$200K
- l l
$0
Aug Sep Oct Nov Dec Jan Feb Mar Apr May Jun Jul Aug
2020 2020 2020 2020 2020 2021 2021 2021 2021 2021 2021 2021 2021

Reference lines and bands

You can add reference lines and bands from the Add Analytics menu for an axis.
There are several pre-configured lines and bands to choose from, but in this

example we'll choose a blank Reference Lines and Bands item.

LEFT AXIS REPEAT /' RIGHT AXIS /' OTHER /"
+ Add Data + Add w[ytics alendar Period Bar Color

5 Perinds Farlier-Cuirrant Parind Manual Colors
I Product Revenue Add Analytics

Range
l Training Revenue SUMMARIZE

I Book Revenue

= A | I

Bar Stack Area Stack Constant Line Average Line Maximum Line

$500K

$400K | 1, 1=

e Minimum Line Goal Lines Scoring Bands Reference Lines

g And Bands
$200K
TREND-LINE
$100K
o B e -
Aug

2021 Trend Line o

This adds a Reference Lines and Bands item to the axis.
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LEFT AXIS REPEAT /' RIGHT AXIS # OTHER /'

+ Add Data + Add Analytics Calendar Period Bar Color
5 Periods Earlier-Current Period Manual Colors
l Product Revenue I = X and Y Axes
All Labels, Auto Range
I Training Revenue |
Data Table
l Book Revenue il = Hidden
ReferencelinesandBands — @) =
+ AddLine
Click on '+ Add Line'
% | I- I- I- I-
Mar Apr May Jun Jul Aug
2021 2021 2021 2021 2021 2021

We'll click "Add Line" and then set the data source. First, we'll choose to show

each scorecard item's goal.

Set Data Source

Line Data Source

Scorecard Item Field

Scorecard Item Field

Goal

The chart now looks like this. There's a goal line on every bar that we've made

green, and we've chosen “"Goal" for the line's label.
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LEFT AXIS REPEAT /' RIGHTAXIS /' OTHER /'

+ Add Data + Add Analytics Calendar Period Bar Color
5 Periods Earlier-Current Period Manual Colors
I Product Revenue i = Xand Y Axes
All Labels, Auto Range
I Training Revenue | M
Data Table
I Book Revenue | M Eiicgen
Reference LinesandBands = @B =
+ Add Line
Fill 1
— Goal Edit Line
Fill 2 SHOW LINE a
Set Label
$200K Set Data Source
Color e >
$100K
Duplicate
% [ [ [ [
Mar 1 Delete May Jun Jul Aug
2021 2021 2021 2021 2021

Let's see what a different data source looks like for the line. Here we'll choose a
constant number of 300,000.

Set Data Source

Line Data Source

Constant Number

Value

300000

After changing the line color and label, it now looks like this.
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LEFT AXIS REPEAT /' RIGHT AXIS /' OTHER /"

+ Add Data + Add Analytics Calendar Period Bar Color
5 Periods Earlier-Current Period Manual Colors
I Product Revenue || E X and Y Axes
All Labels, Auto Range
I Training Revenue || E
Data Table
I Book Revenue || = Hidden
ReferencelLinesandBands . §B =
+ AddLine L3
Fill1
~ 300k ?
Fill2
$200K
$100K
" I [ | B B B -
Mar Apr May Jun Jul Aug
2021 2021 2021 2021 2021 2021

You can add as many lines as you want, each with its own data source. Here

we've added a second orange line, this one at 500,000.

LEFT AXIS REPEAT / RIGHT AXIS /' OTHER /'
+ Add Data + Add Analytics Calendar Period Bar Color
5 Periods Earlier-Current Period Manual Colors
I Product Revenue || E X and Y Axes
All Labels, Auto Range
I Training Revenue || E|
Data Table
I Book Revenue || H Hidden
Reference Linesand Bands . € =
+ AddLine
Fill 1
— 500k h
Fill 2
~ 300k h
Fill 3
$100K
s I I N i B
Mar Apr May Jun Jul Aug
2021 2021 2021 2021 2021 2021

There are optional fills above, below, and between lines. Here we're setting the

middle fill to orange. A fill between two lines is also called a band.
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LEFT AXIS REPEAT #° RIGHTAXIS /' OTHER /'

+ Add Data + Add Analytics Calendar Period Bar Color
5 Periods Earlier-Current Period Manual Colors

l Product Revenue || E Xand Y Axes
All Labels, Auto Range

I Training Revenue il =
Data Table

l Book Revenue il, = Hidden

Reference Lines and Bands ; e =

+ Add Line

Fill1

— 500k

" Edit Fill

Fill2 @

— 300k SHOW FILL
Fill2 Set Label

Color
$100K
w N

Mar Apr Jun Jul
2021 2021 2011 2021 2021 2021

You can even turn off the display of the lines to just show the fill.

LEFT AXIS REPEAT /' RIGHT AXIS /" OTHER /'
+ AddData + Add Analytics Calendar Period Bar Color
5 Periods Earlier-Current Period Manual Colors
I Product Revenue || E| XandY Axes
All Labels, Auto Range
I Training Revenue || E|
Data Table
l Book Revenue il = T
Edit Line
ReferenceLinesandBands — @B =  suowLie
Set Label
<+ Add Line
Fill 1 Set Data Source
500k Color
Fill2 Duplicate
200k 1T Delete
Fill3
saonk l
$0 - -
Mar Apr May Jun Jul
2021 2021 2021 2021 2021 mn

Finally, we'll change the line to show the average of all data series.
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Set Data Source

Line Data Source

Aggregated Chart Data

Aggregation Type

<= Average
Choose Data

All Data

All Data &

Product Revenue

Training Revenue

Book Revenue

By default, the scope is the Entire Chart, so you'll see a single line across the

entire chart.

LEFT AXIS REPEAT /' RIGHTAXIS /' OTHER /'
+ Add Data + Add Analytics Calendar Period Bar Color
5 Periods Earlier-Current Period Manual Colors
l Product Revenue I = XandY Axes

All Labels, Autgifange
l Training Revenue I =
Data Table
l Book Revenue i = Hidden
Reference Linesand Bands @B = < Scope
4 AddLine
| ke b
— Linel Entire Chart Calendar Period Data Series

When we change the Scope to "Calendar Period”, however, you'll see the chart

+ Add Fill
. 1 N - .

is now only averaging the series inside of each calendar period, with a separate

red line for each. Notice how the red line jumps slightly from period to period.
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$600K

$500K
$400K
s300K
$200K
$100K
w i . = [ B -

B B ey 5 o s
Forecasting

Line data series have a "Show Forecast” toggle.

LEFT AXIS REPEAT /° RIGHTAXIS /' OTHER /'
<+ Add Data 4+ AddAnal... Sale Date Line Color Manual Colors
cese e e~ ot Month
< Foracast paten Xand Y Axes All Labels, Auto Range
l Sale Price Sum L orecas
Data Table Hidden
Show Forecast
o
$800,000
$700,000 () /O
/ \ o -]
se00000 o o\o / \O —0 /
$500,000

When forecasting is turned on, SMS will show predictions based on historical

values. The area around the predicted line is the confidence interval.

LEFT AXIS REPEAT /' RIGHT AXIS /' OTHER /'
+ Add Data + AddAnal... Sale Date Line Color Manual Colors
sesemeoweaoeMonth
< Forecast e XandY Axes All Labels, Auto Range
I Sale Price Sum °¢® =

Data Table Hidden
Show Forecast ﬁ)

Set Forecast Model
$900,000
$800,000 Confidence Interval> o 1
$700,000 0. () \__-——
/ \o °\ °/
$600,000 ¢ = / 0—O~_ /
~~o 0—0
$500,000
$400,000
$300,000
$200,000
$100,000
$0
Jul Auj Se| Oct Nov Dec Jan Feb Mar r May Jun Jul Aug p
2020 2020 2020 2020 2020 2020 2021 2021 2021 2021 2021 2021 2021 2021 2021 2021
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By default, the confidence interval is 95%, meaning that based on the data
provided, the line has a 95% chance of being in that shaded region in the future.

You can change this to 90%, 99%, or turn it off all-together.

LEFT AXIS REPEAT /' RIGHT AXIS /' OTHER /'
+ Add Data 4+ AddAnal... Sale Date Line Color Manual Colors
Tereomow = 2nt Month
l P 2 < Confidenceint... XandY Axes All Labels, Auto Range
Data Table Hidden
None
90%

$900,000

$800,000 VIR % /O

$700,000 () 99% (<} \————

/ \ = o/

$600,000 o o—__ / \o____o /

$500,000 o

$400,000

Here's an example of SMS detecting a seasonal trend.
90
80
o]
70 o
0 AN
0 O [} O / 7 (-} O
/ (¢ -
50 o o/o / o
o~ / / / o
40 /- o o o
()

30
20
10

0

Q1 Q3 Q1 Q3 Q1 Q3 Q1 Q3 Q1 Q3 Q1 Q3 Q1
2015 2015 2016 2016 2017 2017 2018 2018 2019 2019 2020 2020 2021 2021 2022

Here's a non-seasonal positive trend example.
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1,000

800

AN
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Here's an example of no trend.

10

Aug Oct Dec Feb Apr Jun Aug Oct Dec Feb Apr Jun Aug Oct Dec Feb
2019 2019 2019 2020 2020 2020 2020 2020 2020 2021 2021 2021 2021 2021 2021 2022

You can tweak the forecast settings by choosing “Set Forecast Model".

LEFT AXIS REPEAT /‘ RIGHT AXIS /‘
4+ Add Data 4+ AddAnal... Sale Date
tertotom v~ ant Month
I Sale Price Sum °0° = < Forecast

Show Forecast %}

<500, 000 Set Forecast Model
)

$800,000 Confidence Interval»

$700,000 (o)

(o]
$600,000 o O\ O\_ / \o___o\n T /
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The default forecast model is Auto, and it's often all you'll need. You can also
choose to ignore recent days, which is helpful for data sources where recent

data is still in flux.

Set Forecast Model

Choose Forecast Model

Auto

Ignore Last Days

Cancel

When the model is set to Auto, SMS tries out several algorithms and chooses
the best fit. If it doesn't detect a trend, it uses Simple Exponential Smoothing. If
it detects a trend but no seasonality, it uses Holt's linear trend (also known as
Double Exponential Smoothing). If it detects seasonality, it uses the Holt-
Winters model (also known as Triple Exponential Smoothing). Both trend and

seasonality are additive, as opposed to multiplicative.

If you prefer to choose the algorithms yourself, you can definitely do that. Auto

Without Seasonality just means it prevents SMS from detecting seasonality.

Set Forecast Model

Choose Forecast Model

Auto Without Seasonality

Ignore Last Days

Cancel
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When you choose a Custom model, you can choose Ignore or Additive for trend
and season. If you choose Additive for season, you can also choose if your

seasonality is quarterly, yearly, etc.

Set Forecast Model

Choose Forecast Model

Custom

Trend

Additive

Season

Additive

Season Length

Monthly

Ignore Last Days

Chart data table

To add a data table to a chart, turn on the “Show Data Table" switch in the
chart's Other panel.
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Edit Chart

LEFTAXIS /' REPEAT /' RIGHTAXIS /' OTHER

Financial Calendar Period Bar Color

2 Months Earlier-Current Month Manual Colors
Customer

Internal Processes Xand Y Axes
All Labels, Auto Range
Organizational Capacity

Data Table Data Table
Hidden

Show Data Table

y

Jun
2021

Cancel

On dashboards, the data table is separately configurable with options to adjust

the font and margin sizes.

Edit Data Table

+ O = 1=l %

Set Table Title

i Font Size Adjustment >
Cell Margin Size >

6
Background >
Size >

4
Data Label a

2
Data Color a
Chart Data a

o

Apr May Jun
2021 2021 2021 Keep In Front
Jataset Exa @ Lock
APR MAY J
[ Chart Table ITEM 2021 2021 I ) T Delete
‘ @ Financial 6.79 7.15 6.66

@ Customer 7.01 7.14 7.29

@ Internal Processes 6.22 5.62 6.81

@ Organizational Capacity 4,13 4,54 4.78

WHAT'S NEW IN 5.0 48



Diagram charts

There are 8 new diagram charts that you can choose from when creating a new

chart. These infographic-stye charts are great for visualizing processes,

relationships, or percentages.

D Mobileworld Inc. B Create Chart

View

03 New Folder

COMBINATION CHARTS

bk

. Line And
Line And Bar Multiple Bar

ANALYTIC CHARTS

A

—

Trend Line Forecast

B

Line And
Stacked Bar

ol

Line And Area

Line And
Stacked Area

MUt Dan

Edit August2021 ~ < >

DIAGRAMS

smx N

Process Cycle

Lty

Timeline

]

Funnel

Pyramid

Tree Map

T
HHH -
]

Filled

Waffle Container

Cancel

All diagram charts have similar configuration options. We'll cover the waffle

chart in detail first, and then summarize the other charts.

Waffle charts

Waffle charts are particularly good at showing percentages. Like all diagram

charts, they can be used in the Charts section on their own, but they're most

useful on dashboards.
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Waffle

Training Venue Costs

Purchases over $50 33%

OPERATING EXPENSES

$5,313 $243K $64.7K $46.1K

Pension Contribution Salaries & Wages National Insurance IT & Communications
(3%)

As with all charts, waffle charts can show data from scorecard items,

initiatives, and datasets.

The size of the container will automatically adjust based on your data. For
example, if your data series is a percentage or has a value between O and 1,
waffle charts will assume your data is a percentage and will set the container
size to 100%. You can also choose a specific container size by clicking on "Total

Container Value" in the Other panel.

Total Container Value

Total Container Value
Auto Constant Number ?

Number

100

Cancel
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Just like every other chart, you can choose to color the filled squares manually

or by performance.

Set Waffle Chart Colors

COLORS Manual Colors Score Colors Specific Color

Cancel

You can also configure what labels to show and how to show them.

Edit Waffle Chart Labels

/| Data Series Name

Abbreviate Charted Values

Default Decimal Precision

Descriptions

None Scorecard Item Description Custom

You can even add multiple data series to a waffle chart. In this example we're

showing three different data series.
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D Mobileworld Inc. Example £ Waffle MR

View Edit June2021 v < >

Name

Waffle

B* Move (3 Copy ™ Delete

4 s
+ Add Data Calendar Period Waffle Chart Colol e
Mankos " Waffle Chart Label
I Financial )
Data Table Hidde
l stoimer tal Container Vals
I Internal Pr

....l l . ... " weoom
o
g g

Filled container chart
Filled container charts visualize your data as liquid in a container. They are

configured exactly the same as waffle charts.

1.00 1.00
0.80 0.80
0.60 0.60
0.40 0.40
0.20 0.20 - !
) 2
0.00 0.00
Customer Satisfaction Survey Spent Marketing Budget
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Process chart
Process charts show a series of discrete stages with a clear progression from

one step to the next. Each stage is represented by a chart data series.

REAQUCe Sdles verneada Cost
A A AT A S A AASU LA A B A A

Improve Profitability

Improve the profitability of all products and services

Timeline chart
Timeline charts are similar to process charts, but they're better at visualizing

specific events. Like all charts, however, the timeline chart can still show data

from scorecard items, initiatives, and datasets.

1 3 5
Increase Quantity of Ad Clicks Develop a web marketing team Research project
100% 75% 100%
c 7 N
& A 4
2 4
Implement New Accounting System Status Update to Board
50% 10%
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Cycle chart

Cycle charts are great at showing repeating processes.

Pyramid chart
Pyramid charts visualize data that builds on a previous level. Like all charts, they

can be colored based on performance...
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4 Improve IT Effectiveness
7.78

3 Improve Customer Satisfa...
4.67

2 Improve Profitability
9.29

1 Increase Revenue
0

.. or they can be colored based on manually chosen colors.

4 Improve IT Effectiveness
8.89

3 Improve Customer Satisfa...
2.67 ¢

Improve Profitability
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Funnel chart
Funnel charts visualize a process where numbers decrease. The chart can

automatically show the percentage remaining between stages.

45% Remaining

8% Remaining

Treemap chart
Treemap charts are slightly different than the other diagram charts because

they only show data from dataset rollup trees. They work by showing the
relative size of data at various levels of the tree. In this example we're showing

data for a military organization, and we're about to click on a box to drill down.
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XVIil Airborne Corps (WAUKFF)
1,921

SMS plays a drilldown animation, and you can then see that item's children in

the rollup tree.

WHAT'S NEW IN 5.0




Reports

Reports in SMS 5 are completely new and represent a major step forward in
functionality. They show data for Scorecard items, Initiative items, and
Datasets. They have formatting, grouping, sorting, filtering, and aggregating. In

short, SMS now has a full-featured report designer for all of the data it tracks.

Creating a report

To create a new report, click the “New Report” button in the Reports section.

[ Mobileworld Inc. Device Sales ® * A B ©
Q View Edit
+ New Report O New Folder
SALE PRICE CUSTOMER NAME SALES EMPLOYEE
$351.44 Kendall Nost Issac Bernhardt
$351.52 Roberto Feltz Issac Bernhardt
$353.50 Lorriane Nevarez Hollie Pennigton
Reports : W Repo $355.05 Chiquita Carrell Delphine Calmes
(5 Charts Deacesales2 $355.41 Adelaide Henneberry Micheline Turkasz
$355.81 Evalyn Chancellor Issac Bernhardt

Each report is for a single type of data. First, we'll choose Scorecards.

New Report: Choose a Type

®
>

Scorecards Initiatives Datasets

You can choose between several pre-built reports like the Red KPIs report and

Missing KPI Values report. These reports get you started with “canned” reports
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that you can configure. Instead, we'll build a report from scratch by choosing

the Advanced Report Designer option on the bottom.

Choose a Scorecard Report

SCORECARDS

%« KPI Comparison Report
Red KPIs Report
Missing KPI Values Report
KPIs by Calendar Report
Scorecard Structure Report
Annual KPI Data Report
Scorecard Attributes Report

Scorecard Item Owner/Updater Report

Advanced Report Designer ?

Cancel Back o—0

The Advanced Report Designer for scorecard items starts by showing the

scorecard item name, owners, and three periods of data for all KPIs.

@ Mobileworld Inc. New Report

View Edit July2021 v < >

In Edit Mode you only see 3 sample Scorecard Items. To see all of the Scorecard Items, switch to the View tab

[E NewReport ROW FILTERS Showing 260 of 431 Scorecard Items + Add

Name
E New Report Scorecard Item Type: is any of the f g: KPI

) 21
JAME WNERS
o K UE K L
Total Revenue Janet Montgomery $866,600 $856,500 $846,500
SEO Project Spend to Date 231,500 231,500 231,500
Nora Roberts
Product Revenue ora Rooetts $555,800  $548,150  $539,600

Scott O'Reilly
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Let's start a new report, and this time we'll choose Initiatives.

New Report: Choose a Type

v

Scorecards Initiatives Datasets

Cancel

A new Initiatives report starts with showing the budget and schedule

information for all non-archived initiative items.

Name ROW FILTERS Showing AlL5 Initiatives 4 Add
New Report Archive Status: is Not Archived

NAME ASSIGNED USERS AND GROUPS PROJECTED BUDGET VARIANCE PROJECTED SCHEDULE VARIANCE

Research project and write a report $3,500 under budget On schedule

Status Update to Board

Develop a web marketing team Sam Smith $42,500 under budget 19 days early

The third type of report is Datasets.

New Report: Choose a Type

-

Scorecards Initiatives Datasets

Cancel
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A dataset report shows data from a single dataset, which we'll choose next.

New Report: Choose a Dataset

@ Mobileworld Inc. 3 Mobileworld
Key Performance Indicators &) Customers
Financial @ Device Sales
Marketing D test
Customer Support @ Sales
Sales ) Sales2
Operations [ pAmIS

Information Technology ) DSAID

¥= Expand All = Expand All

Dataset reports are a little different from Scorecard and Initiative reports
because every dataset field is unique to each dataset. Because of this, dataset

reports start blank.

[ Mobileworld Inc. New Report

View Edit

New Report [ New Folder
In Edit Mode you only see 3 sample Records. To see all of the Records, switch to the View tab

— ROW FILTERS + Add
@ =] NewReport New Report v Filt
App Calendar

None (Show all time) -

G

& Add your first column

¢

Finally, users with the right permissions can choose SQL reports.
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New Report: Choose a Type

Scorecards Initiatives Datasets

Cancel

This allows them to write SQL queries against the SMS database.

SQL Report

SQL QUERY

select * from scorecardnodes

Cancel

SQL reports appear the same as other reports, except they can't have

advanced formatting.

@ Mobileworld Inc. SQL Report B
View Edit
SCORECARDNODEID LEFTBOUND RIGHTBOUND VERSIONID ACTIVATE ARCHIVE CURRENCYSYMBOLISO3COUNTRY
915 1 72 122
916 2 23 86

E] Reports

(’% Charts
917 3 12 72
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The View and Edit tabs

Regardless of whether you're writing reports for Scorecards, Initiatives, or
Datasets, the general flow is the same. The Reports Edit tab always shows the
first three records so you can get a preview of what your report will look like.

View Edit July2021 v < >

In Edit Mode you only see 3 sample Scorecard Items. To see all of the Scorecard Items, switch to the View tab

ROW FILTERS Showing 290 of 436 Scorecard Ite! 4+ Add
Name
New Report Scorecard Item Type: is any of the following: KPI
MAY 2021 JUNE 2021 JULY 2021
NAME OWNERS
° KPI VALUE KPI VALUE KPI VALUE
Total Revenue $697,574 = $697,974 = $701,874
SEO Project Spend to Date 231,500 231,500 231,500
Product Revenue Full User $443,424 $441,624 $442,224

_

When you switch to the View tab, you'll see your entire report.

View Edit July2021 v < >

MAY 2021 JUNE 2021 JULY 2021
NAME OWNERS

KPI VALUE KPI VALUE KPI VALUE
Total Revenue $697,574 $697,974 $701,874
SEO Project Spend to Date 231,500 231,500 231,500
Product Revenue Full User $443,424 $441,624 $442,224
Training Revenue Full User $229,900 $231,050 $234,050
Book Revenue Full User $24,250 $25,300 $25,600
Product Costs $275,799 $275,832 $275,732
Training Venue Costs $39,590 $39,181 $38,606
Book Production Costs $8,339 $7,905 $7,797
Total Cacte <221 83 €227 ]2 €21 78R
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Adding and reordering columns

To add a new column, click the “Add" button where you want the new column to

go.
MAY 2021 JUNE 2021 JULY 2021
NAME OWNERS
KPIVALUE KPIVALUE KPIVALUE
Total Revenue Janet Montgomery $866,600 $856,500 $846,500
SEO Project Spend to Date 231,500 231,500 231,500
ra Roberts
Product Revenue SRkt O'Reilly $555,800 $548,150 $539,600

This brings up a list of all available fields from which to create columns. Here
you can see the placeholder where the new column will go, right before we click

to add the "Data Type" field as a column.

to A MAo A omee —— - -~ 3 sample Scorecard Items. To see all of the Scorecard Items, switch to the View tab
Add Column More Options
ROW FILTERS Showing 260 of 431 Scorecard Ite
T Name Scorecard Item Type: is any of the following: KPI
Hid
I" Description MAY 2021 JUNE 2021 JULY 2021
OWNERS
I" Scorecard Item Type KPI VALUE KPI VALUE KPIVALUE
Janet
# KPIValue ane $866,600  $856,500  $846,500
Montgomery
T Data Type
231,500 231,500 231,500
T Update Type

Nora Roberts

Scott O'Reilly $555,800  $548,150  $539,600

' Aggregation Type
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Immediately after the new column is added, the "Add Column" tooltip stays
open, and you can see a new placeholder column to the right of the new column.

This allows you to add multiple columns quickly with a few clicks.

o mAMLARe s semes oo ==~ 3 sample Scorecard Items. To see all of the Scorecard Items, switch to the View tab
Add Column More Options
:\- \'ju ROW FILTERS Showing 260 of 431 Scorecard Item
/
T Name Scorecard Item Type: is any of the following: KPI
#d
T Description MAY 2021 JUNE 2021 JuLy 2021
DATA TYPE OWNERS
T Scorecard Item Type o KPIVALUE KPI VALUE KPIVALUE
Janet
# KPIValue Currency $866,600  $856,500  $846,500
Montgomery
T DataType 'Aﬂgﬂ'
Standard 231,500 231,500 231,500
T Update Type
Nora Roberts
Currency $555,800 $548,150 $539,600

" Aggregation Type Scott O'Reilly

To change the order of columns, you can just drag and drop them to where you

want them to be.

SALE PRICE

$468.22

SALES EMPLO EPARTMENT

$63€IN6

Hollie Penni

Issac Bernharat | Retail
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Setting column labels

To edit a column, just click on it. You'll see the column that you're going to edit

highlighted, and it shows a tooltip with your editing options.

Column: Sale Price ¥ Edit

Group ‘

Sort using this field

SALES EMPLOYEE SALE PRICE SALES DEPARTMENT
@ - : ®

Hollie Pennigton $468.22 Retail
Hollie Pennigton $635.46 Retail
Issac Bernhardt $437.13 Retail

In this example we'll click the Edit button, and we'll choose "Set Column Label.”

Column: Sale Price $# Edit Edit Column
Group Set Column Label ?
Sort using this field Set Data Source
- Edit Formatting
SALES EMPLOYEE SALE PRICE SALES DEPARTMENT
® ‘ : 1

Hollie Pennigton $468.22 Retail 1ir Delete

Hollie Pennigton $635.46 Retail

Issac Bernhardt $437.13 Retail

This opens a dialog where you can choose to override the Default column label
and type a value of your own. In this example we're going to change the "Sale

Price" label to "Value."
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Set Column Label

COLUMN LABEL Default Custom

Column Label

Value

Here's what the report looks like with the new column label.

SALES EMPLOYEE VALUE SALES DEPARTMENT
Hollie Pennigton $468.22 R
Hollie Pennigton $635.46 Retail

Issac Bernhardt $437.13 Retail

Editing column data

Every report column gets its data from somewhere, and to edit what data is

showing, choose “Set Data Source” from the Edit Column menu.

Column: Sale Price £+ Edit Edit Column

Group Set Column Label

Sort using this field Set Data Source w
Edit Formatting
SALES EMPLOYEE SALE PRICE SALES DEPARTMENT
@ + + 1

Hollie Pennigton $468.22 Retail 1 Delete
Hollie Pennigton $635.46 Retail
Issac Bernhardt $437.13 Retail
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The default column type is Basic. This means the column is showing the value

for a single field.

Edit Column: Set Data Source

Basic Calculated

Field

Sale Price

You can also choose to show a Calculated value in a column. Here we'll change

the Type to Calculated and we'll click the “Set Equation” button.

Edit Column: Set Data Source

Type

Basic Calculated

Data Type

£33 Currency

Equation

Set Equation
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In this example we're building an equation that shows the value of the “Sales
Price" field, but with an additional 7% sales tax added if the value of the

Country field is "United States.” For more information, see the Equations

knowledge base article: https://support.spiderstrategies.com/hc/en-

us/articles/4407643362452

Set Equation

Equation

allowed input:+-*/()

If( [Customers].[Country] =="United States", [Device Sales].[Sale Price] *1.07, [Device Sales].[Sale Price] )

CHOOSE SOURCE FIELD

Dataset Field Aggregation Type

Device Sales Sale Price + Sum

ROW FILTERS

There are no Row Filters

Cancel

<+ Add Row Filter

Finally, it's important to note that you can reach this “Set Data Source” menu

when adding a new column. Most of the time you'll want to choose a field from

the list when adding a column. But, if you know your new column is going to be

more complicated than that, you can just click the "More Options button that's

in the "Add Column” tooltip.

Add Column More Options

(% Customer ID

| time)

Sale Date
Sale Price

SALE PRICE
T Sales Department

$468.22
T Sales Employee

$635.46

$437.13
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SALES DEPARTMENT

Retail

Retail

Retail
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https://support.spiderstrategies.com/hc/en-us/articles/4407643362452
https://support.spiderstrategies.com/hc/en-us/articles/4407643362452

This shows the same "Set Data Source" menu, but this time it's for a column

that hasn't been created yet.

Add Column

Type

Basic Calculated

Field

Show values for

Sometimes when you click on a column, you'll have a “Show Values For"
dropdown. In this example we've clicked on a date column that's showing data

from the Sale Date field, and we're currently showing "Every Sale Date".

Column: Sale Date £+ Edit
ROW FILTERS
Group
Sort using this field
Show Values For e
Every Sale Date @ ~
LILL
SALES EMPLOYEE SALE DATE SALE PRICE SALES DEPARTMENT
Hollie Pennigton Jan1,2016 $468.22 Retail
Hollie Pennigton Jan1,2016 $635.46 Retail
Issac Bernhardt Jan 11,2016 $437.13 Retail
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Here we've chosen to show values for the Quarterly calendar. The column now

shows which quarter the sale happened in instead of the specific date.

Column: Sale Date & Edit

N ROW FILTERS
Group
There

A Sort using this fiel

Show Values For =

Quarterly -

SALES EMPLOYEE SALE DATE SALE PRICE SALES DEPARTMENT
Edmond Zehrbach Quarter 1, 2021 $522.30 Retail
Issac Bernhardt Quarter 1, 2021 $621.02 Retail
Odell Sheler Quarter 1, 2021 $444.41 Retail

You'll see other options in the "Show Values For" dropdown depending on what
data your column is showing. For example, our dataset has four ranges set up
for the Sale Price field.

Add Ranges: Sale Price

RANGES

Small Sale
less than $400

Medium Sale
$400 or more, less than $700

Large Sale
$700 or more, less than $2,000

Very Large Sale
$2,000 or more
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When we click on the column showing the Sale Price field, we can see that it

defaults to “Every Sale Price".

Column: Sale Price £+ Edit
ROW FILTERS
Name
. Group
Device Sales Therearen
App Calendar Sort using this field
None (Show al ghow Values For
Every Sale Price
Every Sale Price
SALES EMPLOYEE
Every Sale Price Range o
Edmond Zehrbach - -
Issac Bernhardt January 2021 $621.02 Retail
Odell Sheler January 2021 $344.41 Retail

If we change “"Show Values For"” to "Every Sale Price Range”, we'll see values
that look like this.

SALES EMPLOYEE SALE MONTH SALE PRICE SALES DEPARTMENT
Edmond Zehrbach January 2021 Medium Sale Retail

Issac Bernhardt January 2021 Medium Sale tail

Odell Sheler January 2021 Small Sale Retail

Column formatting

To edit a column's formatting, choose "Edit Formatting” from the Edit tooltip.
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Edit Column

Column: Sale Price ¢ Edit
Group Set Column Label
Sort using this field Set Data Source
- Edit Formatting h
SALES EMPLOYEE SALE PRICE SALES DEPARTMENT
© : : t
Hollie Pennigton $468.22 Retail 17 Delete
Hollie Pennigton $635.46 Retail
Issac Bernhardt $437.13 Retail

The Edit Formatting dialog gives you a preview of what your formatted data
will look like. Here we've changed the font size to large, changed the color to

dark, abbreviated the data, and aligned everything right.

Formatting: Edit Formatting

D Abbreviate

Default Decimal Precision
Large ~ B|/|u

Dark Color

SALE PRICE
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We end up with a report that looks like this.

SALES EMPLOYEE SALE PRICE SALES DEPARTM

Hollie Pennigton $468 tail
Hollie Pennigton $635 Retail
Issac Bernhardt $437 Retail

Column sorting

You can choose to sort on any field in your report. The default sorting for
scorecard and initiative reports is first by organization, and then by tree order.
You can change this default sorting by clicking on a column and turning on “Sort

using this field."”

Column: Sale Price $£$ Edit
Group

Sort using this field

SALES EMPLOYEE SAL;'l;RICE SALES DEPARTMENT
Hollie Pennigton $468.22 Retail
Hollie Pennigton $635.46 Retail
Issac Bernhardt $437.13 Retail
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You can then choose to sort that column ascending or descending.

Column: Sale Price

Group

@ ) Sort using this field

Low to High

SALES EMPLOYEE
Issac Bernhardt
Hollie Pennigton

Issac Bernhardt

Grouping

You can group by a column by clicking on the column and turning on the Group

switch.

LLL)
SALE PRICE ~

$437.13

$468.22

$514.05

Column: Sales Employee

Group

Sort using this field

Show Values For

Every Sales Employee

LLLI
SALES EMPLOYEE

Edmond Zehrbach

Issac Bernhardt

Odell Sheler

WHAT'S NEW IN 5.0

¢ Edit

SALES DEPARTMENT
Retail
Retail

Retail

£ Edit

SALE MONTH
January 2021
January 2021

January 2021

SALE PRICE

$522.30

$621.02

$444.41

SALES DEPARTMENT

Retail

Retail

Retail
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This shows all unique values for that column as large group headers, and then
lists all of the records with that value underneath. In this example we've
grouped by the Sales Employee column, so each group is a different sales
employee. The Edit tab only shows the first three groups, but switching to the

View tab will show the full report.

Sales Employee: Delphine Calmes

SALE MONTH SALE PRICE SALES DEPARTMENT
July 2021 $746.76 Retail
July 2021 $390.12 Retail
July 2021 $608.76 Retail

Sales Employee: Edmond Zehrbach

SALE MONTH SALE PRICE SALES DEPARTMENT
July 2021 $708.99 Retail
July 2021 $566.96 Retail
July 2021 $716.73 Retail

Sales Employee: Hollie Pennigton

SALE MONTH SALE PRICE SALES DEPARTMENT
February 2020 $725.93 Retail
February 2020 $596.53 Retail
February 2020 $648.47 Retail
SALE MONTH SALE PRICE SALES DEPARTMENT

You can create another level of grouping by selecting another column and

turning on "Group Again”.
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Column: Sales Department £ Edit

Group Again h

Sort using this field

Show Values For

Sales Employee: Delpl Every Sales Department -

SALE MONTH SALEPRICE | SALESDEPARTMENT
° o + &y +

July 2021 $746.76 Retail
July 2021 $390.12 Retail
July 2021 $608.76 Retail

Sales Employee: Edmond Zehrbach

SALE MONTH SALE PRICE SALES DEPARTMENT
July 2021 $708.99 Retail
Julv 2021 $566.96 Retail

In this example the Sales Employees are also grouped by Sales Department.

Sales Department: Corporate é
Sales Employee: Kym Lavender é

SALE MONTH SALE PRICE
July 2020 $16,308.81
July 2020 $785.54
August 2020 $6,497.68

Sales Employee: Russell Corrick

SALE MONTH SALE PRICE
August 2018 $2,070.60

October 2018 $31,485.14
August 2018 $25,334.06

Sales Department: Retail

Sales Employee: Delphine Calmes

SALE MONTH SALE PRICE
L AAma Arnn =
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Hiding individual records

Adding a group to your report opens the door to many new data presentation
possibilities. The most powerful is the ability to turn off “Show Individual
Records”. In this example, we're grouping records by the Sales Employee
column, and we're showing columns for the Sale Date, Sale Price, and Sales

Department.

Column: Sales Employee £t Edit

@ ) Group a ShowlndividualRecords?

Show Groups For

Every Sales Employee v

Sort This Group

AtoZ v

Sales Employee: Delphine Calmes

SALE DATE SALE PRICE SALES DEPARTMENT
July 2021 $746.76 Retail
July 2021 $390.12 Retail
July 2021 $608.76 Retail
| Calar Crmamlaiinn: Cdmmamnmd Tahvlhasl |

When you turn off “Show Individual Records”, the report now only shows the
groups. As you can see, the columns remain the same, but now they're showing
aggregated data for each group. Number columns like Sale Price are summed
by default. The default aggregation type of Date and Text columns is counting

the number of unique values.
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Column: Sales Employee £+ Edit

@ Group Show Individual Records /

Sort This Group

AtoZ v
LILLI
SALES EMPLOYEE # UNIQUE: SALE DATE SALE PRICE SUM # UNIQUE: SALES DEPARTMENT
Edmond Zehrbach 1,666 $2,305,532.83 il
Delphine Calmes 1,687 $2,598,137.46 1
Hollie Pennigton 1,795 $3,076,958.48 i

Let's say we want to show the Average sale price for a group instead of the

Sum of all sale prices. To do this, just choose Set Data Source like we did before.

Column: Sale Price $# Edit Edit Column
Group Again ¥ Set Column Label
Sort Using This Field Set Data Source
Repeat this column by... Edit For A8
T 1ir Delete
SALES EMPLOYEE # UNIQUE: SALE DATE SALE PRICE SUM # UNIQUE: SALES DErrrcrmcvs
®
Edmond Zehrbach 1,666 $2,305,532.83 1
Delphine Calmes 1,687 $2,598,137.46 1
Hollie Pennigton 1,795 $3,076,958.48 1

Now that we're showing aggregated data, however, we have an Aggregation

Type choice in this dialog. We'll choose Average.
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Edit Column: Set Data Source

Type

Basic Calculated

Field

Sale Price

Aggregation Type

== Average

+ Sum
== Average
&= Minimum

=3 Maximum

Mt Number of Unique

Once we click Done, we have a report showing the average sale price for each

employee.
SALES EMPLOYEE # UNIQUE: SALE DATE AVERAGE SALE PRICE # UNIQUE: SALES DEPARTMENT
Edmond Zehrbach 1,666 $614.81 ik
Delphine Calmes 1,687 $614.51 1
Hollie Pennigton 1,795 $622.49 i |

Finally, we'll change the Sale Date aggregation type to "Latest Date”. Our
finished report looks like this on the Edit Tab.
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SALES EMPLOYEE # UNIQUE: SALE DATE

Edmond Zehrbach 1,666
Delphine Calmes 1,687
Hollie Pennigton 1,795

And like this on the View tab.

View
SALES EMPLOYEE LATEST SALE DATE

Delphine Calmes Jul 31,2021
Edmond Zehrbach Jul 31,2021
Hollie Pennigton Jul 31,2021
Issac Bernhardt Jul 31,2021
Kym Lavender Jul 28,2021
Micheline Turkasz Jul 31,2021
Odell Sheler Jul 31,2021
Russell Corrick Jul 29,2021

AVERAGE SALE PRICE # UNIQUE: SALES DEPARTMENT

$614.81 1
$614.51 1
$622.49 1

AVERAGE SALE PRICE # UNIQUE: SALES DEPARTMENT

$614.51 1
$614.81 1
$622.49 1
$616.34
$17,721.23 1
$617.45 1
$617.82 1
$17,977.49 1

Column filters when hiding individual records

Once you're hiding individual records and your report is showing aggregated

data, you can start adding filters to your columns. In this example we're going

to choose "Set Data Source"” for a Sale Price column.
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Column: Sale Price
Group Again

Sort Using This Field

Repeat this column by...

SALES EMPLOYEE LATEST SALE DATE SALE PRICE SUM
Delphine Calmes Jul 31,2021 $2,598,137.46
Edmond Zehrbach Jul 31,2021 $2,305,532.83
Hollie Pennigton Jul 31,2021 $3,076,958.48

£+ Edit Edit Column
Set Column Label
Set Data Source

Edit Format@ing

1ir Delete
# UNIQUE: SALES DErsrcrmer o

We'll leave the aggregation type as sum and click the “Add" button in the filters

panel.

Edit Column: Set Data Source

Type

Basic Calculated

Field

Sale Price

Aggregation Type

+ Sum

FILTERS

There are no Filters

Cancel
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Next, we'll create a filter to only include data from records where the sales

country is Canada or Australia.

Edit Column: Set Data Source

Add Filter

Field

Country (Customers)

Matching
© Sales with Customers matching

Sales with Customers not matching

Filter Type Add Equation

is any Canada  Australia

This is what our new column filter looks like.

Edit Column: Set Data Source

Type

Basic Calculated

Field

Sale Price

Aggregation Type

+ Sum

FILTERS + Add

Sales with Customers matching (Country: is Australia or Canada)
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When we click Done, we now have a column showing the sum of all sales in

Australia and Canada for each employee.

SALES EMPLOYEE LATEST SALE DATE AUSTRALIA & CANADA # UNIQUE: SALES DEPARTMENT
Delphine Calmes Jul 31,2021 $645,452.38 1
Edmond Zehrbach Jul 31,2021 $558,641.06 1
Hollie Pennigton Jul 31,2021 $750,574.47 1

Repeating columns for scorecards

You can create repeating columns for Scorecards, Initiatives, and Datasets
reports, but they're a little bit different for every report type. For Scorecards,

values that change over time are always inside of a repeating column.

Whenever you add a column like KPI Value or Goal, you'll automatically see that

field repeating by calendar period. As you can see in this example, it doesn't

make sense to show a KPI value without knowing what period that KPI value is

for.
MAY 2021 JUNE 2021 JULY 2021 h
NAME ORGANIZATION
KPIVALUE KPI VALUE KPI VALUE
Sales Revenue Sales $5,117,300 $5,240,300 $4,821,600
New Customers Sales 32 33 34
Number of Renewals Sales 40 39 37

To edit repeating columns, just click on them. Just like when you select a

column, selecting a repeating column header shows a tooltip. We'll click the Edit

button.
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Repeating columns: Monthly

Edit

%

E JUNE 2021 JULY 2021 T 2021
NAME ORGANIZATION
KPI VALUE KPI VALUE KPRRALUE o
Total Revenue Mobileworld Inc. Example $698K $702K $7
SEO Project Spend to Date Mobileworld Inc. Example 232K 232K 232K
Test KPI Mobileworld Inc. Example 6 6

This opens the Edit Repeating Columns dialog. We'll change the calendar to

Quarterly, and we'll choose a range of 4 periods.

Edit Repeating Columns

CHOOSE A CALENDAR PERIOD

CALENDAR Quarterly ~

Relative By Date

3 Periods Earlier ~ T0 Current Period ~

Cancel

When we click Done, we now see the KPI value being repeated for four quarters.
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QUARTER 4, 2020 QUARTER 1, 2021 QUARTER 2, 2021 QUARTER 3, 2021

NAME ORGANIZATION

KPI VALUE KPIVALUE KPI VALUE KPIVALUE
Sales Revenue Sales $13,839,900 $14,591,600 $15,230,600 $13,483,100
New Customers Sales 115 114 96 92
Number of Renewals Sales 121 127 120 109

Repeating columns for initiatives

As we mentioned above, repeating columns work a little differently for every
report type. Repeating columns for Initiatives are similar to repeating columns
for Scorecards because there are values like Money Spent that change over
time. Initiatives are different, however, because their repeating columns aren't
required and aren't added by default. Whenever you have a column for a field
that changes over time and it's not repeating, the report will just show the

latest value.

In this example we have a column showing the projected budget variance for

every initiative item. The projected budget variance field does change over time,

but because this column isn't inside of a repeating column header, the report
just shows the most up-to-date values for the projected budget variance. We

do, however, see a "Repeat this column by calendar period” button.

Column: Projected Budget Variance ¢ Edit
Group
Sort Using This Field
Repeat this column by{izoalendar period
LLLI
NEME ASSIGNED USERS AND PROJECTED BUDGET PROJECTED SCHEDULE
GROUPS VARIANCE VARIANCE o
Migrate Servers to Cloud Full User $2,500 under budget 21 days late
Build a SEO Capability Full User $46K under budget 14 days early
Implement New Accountin
P & $15K over budget 61 days late
System
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When we click the button, we now have repeating columns showing how the

projected budget variance has changed over time.

NAME

Migrate Servers to
Cloud

Build a SEO
Capability

Implement New
Accounting
System

JUNE 2021

ASSIGNED USERS

9

PROJECTED
BUDGET
VARIANCE

AND GROUPS

Full User $14.5K under
A budget
$46K under

Full User Budget

$15K over
budget

JuLy 2021 AUGUST 2021
PROJECTED PROJECTED
BUDGET BUDGET
VARIANCE VARIANCE
$2,500 under $2,500 under
budget budget
$46K unde $46K under
budget budget
$15K over $15K over
budget udget

Repeating columns for datasets

PROJECTED
SCHEDULE
VARIANCE

© ©

21 days late

14 days early

61 days late

You can only add repeating columns to dataset reports when individual records

are turned off. That's because we need to first aggregate dataset records for

each group before we can disaggregate the data into repeating columns.

Scorecard and Initiative reports don't have this restriction because their

repeating columns can show values that change over time.

In this example we're grouping by Sales Employee and are hiding individual

records. We now see a "Repeat this column by..." button when you click on any

column other than the one you're grouping by.

SALES EMPLOYEE
Delphine Calmes
Edmond Zehrbach

Hollie Pennigton

WHAT'S NEW IN 5.0

Column: Sale Price

Group Again

Sort using this field

Show Values For

Every Sale Price

Repeat this column by...

1,687

1,666

1,795

$2,598,137.46

$2,305,532.83

$3,076,958.48

£+ Edit

# UNIQUE: SALE DATE SALE PRICE SUM # UNIQUE: SALES DEPARTMENT
9 : ®

1

1
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We'll click the "Repeat this column by..." button and then choose to repeat by

Country.

SALES EMPLOYEE
Delphine Calmes
Edmond Zehrbach

Hollie Pennigton

Column: Sale Price

Group Again

Sort using this field

Show Values For

Every Sale Price

Repeat this column by...

1,687

1,666

1,795

#* Edit

# UNIQUE: SALE DATE SALE PRICE SUM # UNIQUE: SALES DEP
@ §

$2,598,137.46 1
$2,305,532.83 1
$3,076,958.48 1

Repeat By More Options

(% Customer ID

Sale Date

E23 Sale Price

T Sales Department

T Country (Customers) Repeat

T Customer Name (Customers)

We now have a separate Sale Price column for every country.

SALES EMPLOYEE

Delphine Calmes
Edmond Zehrbach

Hollie Pennigton

1,687

1,666

1,795

CANADA

# UNIQUE: SALE DATE

SALE PRICE SUM

$308,250.63
$267,421.59

$360,376.61

AUSTRALIA

SALE PRICE SUM

$337,201.75

$291,219.47

$390,197.86

UNITED STATES
SALE PRICE SUM
$1,365,454.05
$1,224,105.67

$1,607,217.55

Multiple blocks of repeating columns

You're not limited to one range of repeating columns. In this example we're

UNITED KINGDOM

NIQUE: SALES DEPARTMENT
SALE PRICE SUM

$587,231.03
$522,786.10

$719,166.46 1

going to add a new column outside of the first block of repeating columns.
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JUNE 2021
NAME OWNERS

KPIVALUE
Total Revenue % $697,974
SEO Project Spend to Date 231,500

Test KPI

AUGUST 2021?

JULY 2021
KPI VALUE KPIVALUE
$701,874 $712,124
231,500 231,500
6

We'll choose to add another KPI Value column, and now we have two identical

blocks of repeating columns.

JULY 2021

» JUNE 2021

AUGUST 2021

JUNE 2021 JULY 2021 AUGUST 2021

NAME OWNER:

KPI VALUE KPI VALUE KPI VALUE KPIVALUE KPIVALUE KPI VALUE
Total Revenue $697,974 $701,874 $712,124 $697,974 $701,874 $712,124
SEO Project Spend to Date 231,500 231,500 231,500 231,500 231,500 231,500
Test KPI 6 6

Finally, we'll edit each repeating column block to contain a single period, and

we'll drag and drop the blocks next to each other. Now we have a report

showing the KPI value for the current month and the KPI value from the month

one yedr ago.

AUGUST 2020 AUGUST 2021
NAME OWNER
o KPI VALU KPI VALUE
Total Revenue $963,303 $712,124
SEO Project Spend to Date 131,500 231,500

Test KPI
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Repeating columns again

Scorecard, Initiative, and Dataset reports can all repeat columns a second time

when individual records are turned off. For Scorecard and Initiative reports,

repeating again is almost always used when multiple organizations have the

same initiative or scorecard items and you want to compare them across

organizations. For datasets, repeating again is common with all field types.

To repeat again, click on the repeating column header to select it.

AUSTRALIA
SALES EMPLOYEE # UNIQUE: SALE DATE

SALE PRICE SUM

Delphine Calmes 1,687 $337,201.75
Edmond Zehrbach 1,666 $291,219.47
Hollie Pennigton 1,795 $390,197.86

UNITED STATES
SALE PRICE SUM
$1,365,454.05
$1,224,105.67

$1,607,217.55

CANADA UNITED KINGDOM

# UNIQUE: SALES DEPARTMENT
SALE PRICE SALE PRICE SUM o
$308,250.63 1
$267,421.59 1
$360,376.61 1

Then click “Repeat again by" and choose a field. Here we'll repeat by Sales

Department.

Repeating columns by: Country

ﬁ Repeat again by

Show Values For

Every Country

-

[
F AUSTRALIA

UNITED STATES ‘

SALES EMPLOYEE # UNIQUE: SALE DATE

SALE PRICE SUM

Delphine Calmes 1,687 $337,201.75
Edmond Zehrbach 1,666 $291,219.47
Hollie Pennigton 1,795 $390,197.86

SALE PRICE SUM
$1,365,454.05
$1,224,105.67

$1,607,217.55

Repeat again by More Options

@ Customer ID
£7 Sale Price PARTMENT

T Sales Department Repeat
T Country (Customers)

T Customer Name (Customers)

The result is a report with two levels of repeating columns, first by Sales

Department and then by Country.
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RETAIL
UNITED
SALES #UNIQUE: AUSTRALIA CANADA
EMPLOYEE SALE DATE fnenou
SALE PRICE SALE PRICE SALE PRICE
° ° SUM ° SUM ° SUM
Delphine
1,687 $587,231.03 $337,201.75 $308,250.63
Calmes
Edmond
1,666 §522,786.10 $291,219.47 $267,421.59
Zehrbach
Hollie
N 1,795 §719,166.46 $390,197.86 $360,376.61
Pennigton

CORPORATE

UNITED

UNITED STATES

SALE PRICE
SUM

¢

KINGDOM

SALE PRICE
SUM

¢

$1,365,454.05 $0

$1,224,105.67 50

$1,607,217.55 50

AUSTRALIA CANADA

SALE PRICE SALE PRI/
° SUM ° SuUM

$0 S0

$0 50

50 50

h
A

UNITED
B DEPARTM|
CE SALE PRICE
° SUM °
50 1
50 1
50 1

: SALES
ENT

On the Edit tab there are all Os for Corporate sales, but when you go to the

View tab you can see that in this example employees either sell retail or

corporate, never both.

~

View

RETAIL
SALES # UNIQUE: Ly AUSTRALIA CANADA
EMPLOVEE SALE DATE L
SALE PRICE SALE PRICE SALE PRICE
SUM SUM SUM
Delphine
1,687 $587,231.03 $337,201.75 $308,250.63
Calmes
Edmond 1,666 $522,786.10 $291,219.47 $267,421.59
Zehrbach ’ T o o
Hollie
. 1,795 $719,166.46 $390,197.86 $360,376.61
Pennigton
Issac
1,859 $819,492.07 $419,403.16 $425,678.93
Bernhardt
Kym
4
Lavender 31 50 $0 $0
Micheline 1,755 $665,379.83  $36532740  $373,668.11
Turkasz ' T T T
Odell Sheler 1,777 $716,828.74 $398,856.70 $397,922.11
Russell
269 0 0 0
Corrick § § §

Changing header order

UNITED STATES

SALE PRICE
SUM

$1,365,454.05

$1,224,105.67

$1,607,217.55

$1,859,041.49

$0

$1,505,650.29

$1,639,753.17

50

CORPORATE

UNITED
KINGDOM

SALE PRICE

SUM

$0

$0

$1,306,166.74

$0

$0

$1,081,364.71

AUSTRALIA CANADA
SALE PRICE SALE PRICE
SuMm SuMm

50 50

S0 50

S0 $0

$0 $0
$603,707.45 $916,574.81
$0 $0

50 50
$585,248.26 $579,356.99

UNITED STATES

Edit

#UNIQUE: SALES

DEPARTMENT
SALE PRICE
SUM
$0 1
50 1
50 1
50 1

$3,340,537.35 1

50 1

50 1

$2,823,682.38 1

In this example we're showing KPI Value and Goal columns, repeating for 3

periods. The columns are on the bottom and the calendar periods are on top.

NAME

Total Revenue
SEO Project Spend to Date

Product Revenue

WHAT'S NEW IN 5.0

* APRIL 2021

'ORGANIZATION

Mobileworld Inc. Example
Mobileworld Inc. Example

Financial

OWNERS
KPI VALUE
$693,274
231,500
Full User $441,024

MAY 2021
GOAL KPIVALUE
$765,000 $697,574
5,000 231,500
$465,000 = $443,424

GOAL
$765,000
5,000

$465,000

JUNE 2021

KPI VALUE
$697,974
231,500

$441,624

GOAL
$765,000
5,000

$465,000
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To put the columns on top, just drag and drop them vertically.

—— — — - - ———————
EpivAE  GOAL  KPIVALG  GOAL  KPIVALE  GOAL
NAME ORGANIZATION OWNERS[™ . L — — ——
Total Revenue Mobileworld Inc. Example $693,274 $765,000 $697,574 $765,000 $697,974 $765,000
SEO Project Spend to Date Mobileworld Inc. Example 231,500 5,000 231,500 5,000 231,500 5,000
Product Revenue Financial Full User $441,024 $465,000 $443,424 $465,000 $441,624 $465,000

Now the report first groups by column, showing the three periods for KPI Value

and then the three periods for Goal.

KPIVALUE GOAL
NAME ORGANIZATION 0 o

APRIL 2021 MAY 2021 JUNE 2021 APRIL 2021 MAY 2021 JUNE 2021
Total Revenue Mobileworld Inc. Example $693,274 $697,574 $697,974 $765,000 $765,000 $765,000
SEO Project Spend to Date Mobileworld Inc. Example 231,500 231,500 231,500 5,000 5,000 5,000
Product Revenue Financial Full User $441,024 $443,424 $441,624 $465,000 $465,000 $465,000

Hiding repeating column headers

Some reports have only one column, for example KPI Value. Other reports have

only one repeating value, for example a single calendar period. In these
situations, you can choose to hide either the column or the repeating value

header.

For example, here we're showing the KPI Value for three months. The KPI Value

isn't adding a lot to the report in this situation, so we've dragged the column

header to the top.

WHAT'S NEW IN 5.0

92



NAME

Total Revenue
SEO Project Spend to Date

Product Revenue

KPIVALUE
ORGANIZATION OWNER:

APRIL 2021 MAY 2021 JUNE 2021
Mobileworld Inc. Example $693,274 $697,574 $697,974
Mobileworld Inc. Example 231,500 231,500 231,500
Financial Full User $441,024 $443,424 $441,624

We then select the column and turn on "Hide This Header"”. On the Edit table

the header now has an icon showing that it's hidden.

NAME

Total Revenue
SEO Project Spend to Date

Product Revenue

Column: KPI Value £ Edit
Sort using this field
@) Hide This Header
LLLI
@’ IA
ORGANIZATION OwNERs ()
APRIL 2021 MAY 2021 JUNE 2021
Mobileworld Inc. Example $693,274 | $697,574 | $697,974
Mobileworld Inc. Example 231,500 231,500 231,500
Financial FullUser | $441,024 | $443,424 | $441,624
J

On the View tab the column header is no longer visible.

View @

NAME

Total Revenue

SEO Project Spend to Date
Product Revenue

Training Revenue

Book Revenue

Product Costs

WHAT'S NEW IN 5.0

Edit June2021 v <

ORGANIZATION OWNERS APRIL 2021 MAY 2021

Mobileworld Inc. Example $693,274 $697,574
Mobileworld Inc. Example 231,500 231,500
Financial Full User $441,024 $443,424
Financial Full User $228,650 $229,900
Financial Full User $23,600 $24,250
Financial $275.841 $275,799

JUNE 2021
$697,974
231,500
$441,624
$231,050
$25,300

$275,832

>
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When you're repeating again, you can even hide two levels of headers. In this
example we're showing data for a single field and for a single calendar period.

We've chosen to hide all of the headers except the KPI name.

_
— ¢ = 0

SALES PRODUCT SALES TRAINING SALES BOOK SALES NEW NUMBER OF CLOSE
REVENUE REVENUE REVENUE REVENUE CUSTOMERS RENEWALS RATIO
sales
{ 663K 402K 225K 35.7K 5 8 0.33
template)
Africa 318K 128K 167K 23.2K 3 7 0.39
Australasia 505K 244K 243K 18.1K 4 2 0.23

Notes columns

When you add a notes column to your report, there's a “Set Note Display”

option in the menu.

Column: Notes £+ Edit Edit Column

T Set Column Label

JUNE Jury AUGUST
Set Data Source o 202% 2021
NAME NOTES
. KPI KPI
o ¢ Set Note Display & VALUE ° VALUE ° KPIVALUE o
Applies to All Time by Spider Impact Administrator on May 15, 2018: Edit Form
Total Revenue I'm excited about how we're tracking revenue. For the first time, we have | $698K $702K $712K
ERP systems talking with our data visualization tools. Great work team! 1T Delete
SEO Project
Spend to Date 232K 232K 232K
Test KPI 6 6

This allows you to choose not only the type of notes to show for your report, but

also the inform from each note you want to see.
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Set Notes Display

NOTES TO SHOW

NOTE TYPE All

Period Specific Only General Only

CALENDAR Current Calendar ~

2 Periods Earlier ~ TO Current Period ~

NOTE DETAILS

/| Created Date

/' Author

/| Calendar Period
Scorecard ltem

' Replies

Notes from Descendants

Cancel

Weight columns

A scorecard item’'s weight can change over time, but it often doesn't. If you add

a Weight column to your report, it will show the most recent weight for that

item.

NAME

Total Revenue

SEO Project Spend to Date

Test KPI

WHAT'S NEW IN 5.0

JUNE 2021
WEIGHT

KPI VALUE
25% $698K
75% 232K
20%

JULY 2021

KPI VALUE
$702K

232K

AUGUST 2021

KPI VALUE
$712K

232K
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If you add a Weight column inside of repeating calendar periods, it will show

what the weight was at the end of the period. In the example, the "SEO Project

Spend” KPIl weight changes in August.

®

JUNE 2021 JULY 2021 AUGUST 2021
NAME
KPI VALUE WEIGHT KPI VALUE WEIGHT KPI VALUE WEIGHT
Total Revenue $698K 25% $702K 25% $7T12K 25%
SEO Project Spend to Date 232K 50% 232K 50% 232K 75%
Test KPI 6 20% 6 20%

“Scorecard items in multiple organizations” filter

There's a new report filter called “Scorecard Items in Multiple Organizations”.

Report Writer: Add Row Filter

Choose something that you want to filter on. This will limit your report to only
showing rows for scorecard items that match your filter.

Some types of row filters have calendar period ranges. These are different from the
calendar period range you choose for columns. By keeping row filter ranges separate
from column ranges, your reports can be much more flexible. For example, you can
show the current performance of all KPIs that were red at any poi

Filter On

Scorecard Items in Multiple Organizations
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This allows you to select scorecard items that are similar across multiple
organizations. First you choose which organizations you want to include. In this

example we're choosing four organizations that share the same template.

Scorecard Items in Multiple Organizations

ﬂj] CHOOSE ORGANIZATIONS SELECTED ORGANIZATIONS
us
this organization

@ Customer Support

Latin America
® sales

this organization

Australasia
this organization
@ Africa
Africa

@ (sales template) < —
this organization

@ oOperations

¥= Expand All

Cancel

Then you choose which scorecard items you want. When you're done you end up

with the same scorecard items for multiple organizations.

View Edit July2021 ~ < >

MAY 2021 JUNE 2021 JULY 2021
NAME ORGANIZATION

KPI VALUE KPI VALUE KPI VALUE
Sales Revenue Sales $5,117,300 $5,240,300 $4,821,600
New Customers Sales 32 33 34
Number of Renewals Sales 40 39 37
Close ratio Sales 32.06% 31.01% 30.63%
Sales Revenue (US) us $3,471,500 $3,495,500 $3,262,400
New Customers (US) us 24 26 25
Number of Renewals (US) us 23 23 23
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KPI comparison report built on report designer

Creating a KPl comparison report in SMS 5 is exactly the same as it was before.

Choose a Scorecard Report

SCORECARDS

-

o b

G B [ G

¥

KPI Comparison Report

Red KPIs Report

Missing KPI Values Report

KPIs by Calendar Report

Scorecard Structure Report

Annual KPI Data Report

Scorecard Attributes Report

Scorecard Item Owner/Updater Report

Advanced Report Designer

Cancel

First you choose which organizations you want.

KP1 Comparison Repo

[ cHOOSE ORGANIZATIONS

@ Customer Support

@ sales

atin America
Australasia
@ Africa

@ (sales template)

@ Operations

Cancel

WHAT'S NEW IN 5.0

rt

= Expand All

SELECTED ORGANIZATIONS

us

this organization

Latin America

this organization

Australasia

this organization

Africa

this organization
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Then you choose the KPlIs.

KPI Comparison Report

© CHOOSE METRICS SELECTED SCORECARD ITEMS
Sales Revenue
New Customers

© SalesYTD
Number of Renewals

O Number of Sales
Close ratio

© New Customers YTD

© Number of large Sales

© Number of sales calls

@ Closeratio

¥= Expand All

Cancel

And finally you choose your report options.

KPI Comparison Report

SELECT CALENDAR PERIOD

CALENDAR Current Calendar ~

Current Period ~

DISPLAY SETTINGS

Show calendar column

Show goal column

+/ Invert axes (lists the organizations on the left and the KPIs on the top)

Show Abbreviated Values

Cancel

The result is a report showing the KPI values across the organizations.
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(]

ORGANIZATION = ¢

SALES REVENUE PRODUCT SALES REVENUE
Africa 4 $318K $128K
Australasia $505K $244K
Latin America $579K 4 $390K

TRAINING SALES REVENUE

$167K
$243K

$147K

BOOK SALES REVENUE NEW CUSTOMERS NUMBER OF RENEWALS CLOSE RATIO
$23.2K g $3 g $7 £ $0.39
$18.1K $4 $2 7 s023
$42.3K $1 4 $6 $0.34

@

What's new in SMS 5, however, is that the KPI comparison report is built on the

new report designer. That means you have full formatting capabilities as well as

the ability to show additional information. For example, here we're showing
both the KPI's value and its Goal.

]
PRODUCT SALES
ORGANIZATION Szl REVENUE
KPI GOAL KPI GOAL
VALUE SUM VALUE SUM
Africa " $318K  $890K  $128K  $600K
Australasia ' $505K  $890K ' $244K  $600K
Lt $579K  $890K $300K  $600K
America

TRAINING SALES
REVENUE
KPI GOAL
VALUE SUM
"$167K | $250K
" 5243k $250K
4
$147K  $250K

BOOK SALES
REVENUE

KPI GOAL

VALUE SUM

T6232K | 40K

"$18.1K  s40K
4

$423K  $40K

And here we're showing the KPI values for two periods.

°¢
PRODUCT SALES

ORGANIZATION SALES REVENUE REVENUE

JuLy AUGUST JuLy AUGUST

2021 2021 2021 2021
Africa Psarrk U s318k | satrk U ¢318K
Australasia  $418K  $505K | $418K | $505K
Latiy $665K  $579K $665K  $579K
America
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TRAINING SALES
REVENUE
JuLy AUGUST
2021 2021
Tsark 318K
"sa18K | $505K
$665K  $579K

BOOK SALES REVENUE
JuLy AUGUST
2021 2021

Psark 7 318k
Psa1sk 7 ss0sk
$665K  $579K

NUMBER OF
NEW CUSTOMERS RENEWALS
KPI GOAL KPI GOAL
VALUE ° SUM o VALUE o SUM
Vi Tue |7 ST 56
44 $6 $2 $6
$1 $6 $6 $6
NUMBER OF
NEW CUSTOMERS RENEWALS
Juy AUGUST Jury AUGUST
2021 2021 2021 2021
Teark U $318K $477K | $318K
"sa18K | $505K | $418K | $505K
$665K $579K $665K $579K

¢

CLOSE RATIO
KPI GOAL
VALUE SUM
75039 $0.40
"$023  $0.40
4
$0.34  $0.40
CLOSE RATIO
JuLy AUGUST
2021 2021
Psark 7 ga1sk
"sa18k " $505K
$665K  $579K
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Datasets

Clustering analytics for datasets

With Datasets, SMS can explore large amounts of unstructured data. With

data clustering, you can unlock powerful insights by analyzing the relationships

between your datasets’' multiple fields. Clustering creates profiles in your data,

helping you to understand the types of records most likely to show up in your

dataset.

Clustering is best explained by example. Let's imagine that we have a dataset
of customers, and we want to discover the types of people who buy our

products. Each point on the scatter plots below represents a customer. Let's

imagine that the X axis is age, and the Y axis is income.

1 -
0.9 4
0.8 |
°
1 o
0.7 ....." l .‘o
l&.
0.6 + o e ﬁ
° ® "“. ..
05 Q: 000 oo 0
@ o
o )
| e oINS,
o 3380 Y
.. .‘..‘ L
03 + ° & 5. o° 0
°® Jvo P ® '. °
.'...% P ‘ ' PY ®
02 + ° Vb:. o Yy
- ¢ °%e .‘
.'o LX 1S ’ ®
0.1 + o o L )
o ..
0 I I I I I I I I I i
0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1
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We can see that the clustering algorithm has found three clusters in the data.

The three demographics of people who buy this product are young high-income

people, middle-aged low-income people, and older middle-income people.

Looking at two dataset fields is interesting, but now let's imagine extending
these scatter plots into a 3rd dimension by adding a Z axis. In addition to
tracking age and income, let's say that we're also tracking years of formal
education. By seeing points in 3-dimensional space, we could find even more
interesting clusters of people. We could discover that our product is often
purchased by older, higher-income people with little formal education, or

middle-aged, low-income people with graduate degrees.

The human mind has trouble imagining data in more than 3 dimensions, but
clustering algorithms do not. The more dimensions of data that you're able to
provide to SMS, the more powerful it becomes. Your datasets have dozens of

fields, and there are meaningful insights to be discovered.

To create a clustering field in your dataset, click the “Add" button in the Fields
table on the Edit tab.

Explore Records Edit
FIELDS + Add
NAME DATA TYPE SOURCE EDIT HIDE CATEGORIES & RANGES

Customer ID Dataset link to Customers O Customer ID VA i)
Sale Date Date O sale Date s W
Sale Price Currency O sale Price 4ranges W
Sales Department Text B Sales Department no categories 7w
Sales Employee Text ? Sales Employee no categories V. i)

Then choose Data Clusters from the field type.
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Add Field

Type Equation

[ calculated Set Equation

B Calculated

B Basic

ikt Data Clusters

Data Type

T Text

Allow This Field's Values To Be Overridden

Hide From Non-Administrators

Cancel

Next, choose which fields you want to cluster on and click the Analyze button.

Add Field

Type Clustering Fields

% Data Clusters Subjectl Age at the Time of Incident ~ Age at the Time of Incident ~ Grade

Number Of Clusters

Auto Analyze h

Name

Cluster Test 1

Field Group

Allow This Field's Values To Be Overridden

v/ Hide From Non-Administrators

This opens a second-level dialog showing the quality of various numbers of
clusters. You can see here that 17 clusters is the best fit for our data, but that 6

clusters is almost as good.
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Analyze

6 T 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25

Number Of Clusters

NUMBER OF CLUSTERS 17 18 15 16 22 19 20 21 23 24

QUALITY 12.6K 12.5K 12.4K 12.3K 12.3K 12.2K 12.2K 12.2K 121K 11.9K

In this situation we want to go with 6 clusters to keep things simple, so we'll tell
SMS that we want 6 clusters instead of "Auto”.

Add Field

Type Clustering Fields

i Data Clusters Subjectl Age at the Time of Incident ~ Age at the Time of Incident

Number Of Clusters

6 Analyze

Name

Cluster Test 1

Field Group

Allow This Field's Values To Be Overridden

+/ Hide From Non-Administrators

Cancel

Finally, we'll give each cluster a name based on its characteristics for each of

the fields we've chosen.
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Edit Cluster Names

CLUSTER NAME NUMBER OF RECORDS SUBJECTL AGE AT THE TIME OF INCIDENT CENTER VICTIM AGE AT THE TIME OF INCIDENT CENTER VICTIM GRADE CENTER

Academy 4339 43 18 5

Cluster 2

Cluster 3

Cluster4

Senior Staff

Invalid Data

Cancel

We can now use our new data clusters field just like we would any other dataset
field. The cluster that a record falls into is the cluster field's value. In this
example we've added the field to the Datasets Explore tab, but you can also use

it in Reports, Charts, and Dashboards.

CLUSTER TEST l/ # W
CLUSTERTEST1 NUMBER OF INCIDENTS INCIDENT %

Young Recruits 1,992 41%

Academy 1,799 37%

Senior Staff 566 11.7%

Ready to Retire 279 5.7%

Promotable 217 4.5%

Other 5 0.1%

RELATIONSHIP TO SUBJECT e ﬁ

< Back | is undefined
RELATIONSHIP TO SUBJECT NUMBER OF ASSAULTS ASSAULTS %

Acquaintance 4,858 100%

SMS uses the k-means++ algorithm for clustering, and each cluster's quality is

evaluated using the Calinski Harabasz index. https://en.wikipedia.org/wiki/K-

means%2B%2B#Improved initialization _algorithm
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Dashboards

Reorganized dashboards "add widget” menu

The "Add Widget" menu for dashboards has been reorganized to make adding

widgets more intuitive. There are now sections for both Datasets and Charts &

Reports.
@ Mobileworld Inc. Example Add Widget
° —
A = - </ >
Image Text Bubble Embedded
OREC
J % —
A —
Speedometer Linear Gaug Scorecard Not
f— = ot
» — o
- e Lo
Gantt Initiative Notes Initiative Chart
- — =
2
Table Dutasst Filter

» @ =

New Chart Existing Chart New Report Existing Report

Editing reports and charts on dashboards

o 'y ©

Edit August2021 v < >

Cancel. m

Editing charts and reports on dashboards is now done in a full-screen dialog.

Here we're choosing "Edit Chart” on a dashboard widget.

[» Move (3 Copy T Delete
+ O = 1= 93

Edit Widget

Edit Chart &

w

~
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Size
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Keep In Front
A Lock

4 (3 Duplicate
{1 Delete

Cancel m
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The dialog that opens has all of the chart building functionality from the Charts

section. You can see the changes you make to your chart instantly.

Edit Chart

LEFT AXIS REPEAT /' RIGHT AXIS /* OTHER /'

+ Add Data + Add Analytics Calendar Period Bar Color Manual Colors

2 Month: lier- Month
lonths Earlier-Current Monti Bar Labels

I Financial

XandYAxes All Labels, Auto Range

I Customer Data Table Hidden

I Internal Processes

l Organizational Capacity

Apr

2021

Cancel m

nepun

3» Move (3} Copy B Delete

&+ ) = 1= %3 L3 Fullscreen
JUNE2021 V) Edit Widget
NAME DESCRIPTION OWNE
KPI VALUE KPI VALUE
Edit Report
This measure sums:
Total Revenue ) Prc.dlect il $698K $698K SerReporte
- Training Revenue
- Book Revenue Font Size Adjustment >
Retail Sales $427K $427K Cell Margin Size >
US Sales § $337K $337K Background >
Us sales $ $337K $337K Size >
Canada Sales Column Headers @)
Canada Sales § $82.7K $82.7K Keep In Front
Proi
SEO Project Spend to Date 232K 232K @ Lotk
3 Duplicate
& Repor T Delete
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Again, this is exactly the same way as you'd edit reports in the Reports section.

Edit Report

ROW FILTERS + Add

Specific Scorecard Items: is any of the following: Mobileworld Balanced Scorecard and descendants Color: is any of the following: Red between Current Period and Current Period

Scorecard Item Type: is any of the following: KPI

JUNE 2021
DESCRIPTION OWNERS
KPI VALUE KPI VALUE

¢

This measure sums:
- Product Revenue

- Training Revenue
- Book Revenue

Total Revenue

Retail Sales

US Sales §

Canada Sales

Canada Sales $

SEO Project Spend to Date

Cancel
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Scorecards

KPl update approval

There's a new application configuration setting called "Require Owner Approval
For KPI Value Updates" that defaults to off.

S5.54%

Dataset Rollup Trees
Require Owner Approval For KPI Value Updates

Application Administration e
o -

Server Administration
Reauire Note When Undating KPIs That Have A Score Less Than
When enabled, all updates to KPIs that have owners will go into an approval
queue. KPl owners will receive an alert that they have values to approve, and

they can visit the Approve KPIs screen in the Home section to do this.

Home
KPI PERIOD v||X NEW VALUES OLD VALUES USER
Welcome
FINANCIAL
Alerts €9
Update KPls June 2021 v || X KPI Value: $35K James Jones (&
Approve KPIs €19 / Book Revenue October 2021 v || x KPI Value: $35K JamesJones (=
My KPIs
November 2021 v X KPI Value: $39K James Jones 5]
My Tasks
June 2021 v X KPI Value: $450K James Jones =

Product Revenue

October 2021 v || % KPI Value: $450K James Jones  [E
June 2021 v X KPIValue: $255K James Jones =
Training Revenue
October 2021 v || KPI Value: $255K JamesJones =
MARKETING
June 2021 v || X KPIValue: 9 James Jones =
tuhi 2021 el s WDI\/alin: 10 Lamas Innne =

You can approve or reject all pending updates in your queue by clicking on one

of the "all” buttons on the top of the list and then clicking Save.
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Home

KPI PERIOD \/@ X NEW VALUES OLD VALUES USER
Welcome
FINANCIAL Approve All New Values

Alerts €9

D!

Update KPIs X

Approve KPis €59

U

Book Revenue v/ X

My KPls

]

X
]

My Tasks

X
!

Product Revenue

Training Revenue

MARKETING

4 Cancel

You can also select individual updates to be approved or rejected.

KPI PERIOD v X NEW VALUES OLD VALUES USER
FINANCIAL
June 2021 v X KPI Value: $35K James Jones =
Book Revenue v =
ME =
June 2021 v X KPI Value: $450K James Jones =

If a KPI has no owners, or if its only owner is the person who updated the KPI
with a new value, the update will not go into the approval queue and will

instead appear immediately.

Editing multiple scorecard items at once

Mass-edit functionality has been moved to the Administration section. And has
been redesigned to be optimized only for editing. To start, click the “Choose a
Field to Edit" button.
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Application Administration FIELD ROW FILTERS + Add

Server Administration Choose a Field to Edit /" There are no Row Filters
Spider Impact Databases

License Management
There are no fields to edit. Choose a field to edit with the button at the top of this page.

MONITORING
Diagnostics
Current User Activity
View Log Files

Background Process Status

ADVANCED

Mass Edit Scorecard Items h

Recalculate All Scores
Tree Fixer
SQL Console

Generate Demo Data

i

In this example we'll choose Owners.

Field to Edit

ALL ITEM TYPES KPIS ONLY
T nName T Aggregation Type
T Description () calendar

& Owners

8

Currency

-

Tags Data Type

Weight Decimal Precision

H H#

Start date Default Threshold

Archive date

-

Equation

T

Item Type Missing Value Treatment

-3

Template Rollup Equation

-

Scoring Type

Units

- =

Update Type
Updaters
Are higher values better?

Is yes good?

Next, we'll add a filter to choose which scorecard items show up to edit.
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FIELD ROW FILTERS + Add

Owners /' There are no Row Filters

There are no scorecard items to edit. Choose the items you want to work with by adding filters above.

The default filter is "Specific Scorecard Items," and we'll use that here.

Mass Edit Scorecard Items: Add Row Filter

Choose something that you want to filter on. This will limit your report to only
showing rows for scorecard items that match your filter.

Filter On

Specific Scorecard Items

Cancel

We'll add the entire "Mobileworld Balanced Scorecard” and click Done.

Filter: Specific Scorecard Items

NAME ORGANIZATION

Mobileworld Balanced Scorecard Mobileworld Inc. Example
Show descendants of linked items

SCORECARD ITEM

O SPIDER IMPACT [3) Mobileworld Balanced Scorecard
O YOUR TRIAL ENVIRONMENT A Financial
@ Mobileworld Inc. Example A Customer
@ Key Measures A Internal Processes

@ Financial A Organizational Capacity

@ Marketing © TestKPI

@ Customer Support

® sales

¥= Expand All ¥ Expand All

Cancel
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Now we can see all of the scorecard items for the Mobileworld Balanced
Scorecard. You can edit a few at a time, but we're going to select all and click
"Edit Selected ltems".

Import Connections
FIELD ROW FILTERS Showing 37 of 440 Scorecard Items + Add
CONFIGURATION
Owners /' Specific Scorecard Items: is any of the following: Mobileworld Balanced
Calendars Scorecard and descendants
Dataset Rollup Trees
Application Administration =3 NAME ORGANIZATION OWNERS
Server Administration v Mobileworld Balanced Scorecard Mobileworld Inc. Example
Spider Impact Databases . . )
v Financial Mobileworld Inc. Example
License Management
v Increase Revenue Mobileworld Inc. Example
MONITORING
v Product Revenue Mobileworld Inc. Example Full User
Diagnostics
Current User Activity v Training Revenue Mabileworld Inc. Example Full User
View Log Files % Book Revenue Mobileworld Inc. Example Full User
Background Process Status
v Total Revenue Mobileworld Inc. Example
ADVANCED
v Improve Profitability Mobileworld Inc. Example
Mass Edit Scorecard Items
v Net Operating Profit (before tax) Mabileworld Inc. Example
Recalculate All Scores
Tree Fixer v % Net Operating Profit Mabileworld Inc. Example
SQL Console v Reduce Sales Overhead Cost Mobileworld Inc. Example
Generate Demo Data
v Sales & General Admin Mobileworld Inc. Example
4 Edit Selected Items

We'll add the Human Resources group as owners.

Edit Selected Items: Owners

ACTION Add the following owners

OWNERS

Human Resources (Update Users)

Cancel
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After clicking Save, we see a message summarizing all of the changes that were

made. If some of the changes didn't work, it explains why as well.

FIELD ROW FILTERS Showing 37 of 440 Scorecard Items 4+ Add

Owners /' Specific Scorecard Items: is any of the following: Mobileworld Balanced

Scorecard and descendants

You successfully edited 0 scorecard items.

These items were not updated because they are linked items:
* Product Revenue

* Sales & General Admin

e Customer Churn

* 14 more....

These items were not updated because the assignees do not have permission to the item:
* Organizational Capacity

* Improve Knowledge and Skills

¢ |mprove Contract Management

e 17 more....

@ NAME ORGANIZATION OWNERS

Editing charts on Scorecards Overview

You can edit charts on the Scorecards Overview by clicking on the chart's edit
button.

@ Mobileworld Inc. Example Financial ) * | A B & )
Overview KPis @ Edit June2021 v < >
inancial Perspective - All matters related t HISTORICAL PERFORMANCE /7

2 Mobilew anced Sco . the financial aspect of the busi 8

A Financial . PERFORMANCE 7

m ¢

3 Scorecards : i K it * 1

[ Initiatives 6.18

SCORE Jun  Jul Aug Sep Oct Nov Dec Jan Feb Mar Apr May Jun
20 2020 2020 2020 2020 2020 2021 2021 2021 2021 2021 2021

2020 202
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This opens a chart editing dialog with all of the functionality of the new Charts
section. You can add things like background thresholds, reference bands, and

other data series.

Edit Chart

LEFTAXIS /' REPEAT /' RIGHTAXIS /' OTHER /'
Financial Calendar Period Line Color Score Colors
12 Months Earlier-Current Month z
Line Labels

Xand Y Axes All Labels, Auto Range

Cancel
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Import and Export

Regular expression transformations

Regular expressions are incredibly powerful for text matching, but they can also

be used to transform your data. For example, let's say you have a field that has

text values like this:

e 1440x900 pixels
e 1600x900 pixels
e 800x600 inches

And you want to convert it to values like this:

e Width: 1440xHeight: 900 pixels
e Width: 1600xHeight: 900 pixels
e Width: 800xHeight: 600 inches

You can do this by choosing the "matches regular expression” filter type and

writing a regular expression with groups. You can then manipulate the groups

as separate transformations.

Add Transformation

IF FILTER TYPE

Customer ID v matches regular expression... ~

L THEN TRANSFORM ACTION

1st group in the regular expression ~ by prepending...

L THEN TRANSFORM ACTION

2nd group in the regular expression ~ by prepending...

Ly Add THEN

REGULAR EXPRESSION

/([0-91+)x([0-9]+)/

PREFIX

Width:

PREFIX

- Height:

Here are a few examples of how transformations will show up. There are more records that will be transformed.

EXAMPLE DATA TRANSFORMATION

There is no transformation data to show

Cancel
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"By converting to date" transformation

There is a new transformation called "by converting to a date” that you can
apply to any type of data that you're importing. You tell the software where to
find the day, month, and year, and it turns text into dates.

Add Transformation

IF

All Records

L THEN TRANSFORM ACTION SOURCE DATE FORMAT

Date New Cust = by converting to date... ~ my/d/fy

L, Add THEN

Here are a few examples of how transformations will show up. There are more records that will be transformed.

EXAMPLE DATA TRANSFORMATION

CUSTOMERS PM

HOSTED PRODUCT PAYING RENEWAL SALE VALUE ‘mwf‘; i PRI UNIT
MONTHLY - PRICE

PM

PAYMENT ACCOUNT
CUSTOMER USER

FORM OWNER

12/13/18

Credit Benjamin uickScore 5
o ° 165.508499497896 to: Dec
Card Himmelfarb - Hosted 13

2018

11/18/18

Beniamin OuickScore

Cancel

Days, months, and years are represented by the following characters:

e d
e m
° Y

To separate the days, months, and years, any number of the following

characters can be used

e space ()
e hyphen (-)
e comma(,)

e forward slash (/)
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For example, if your dates look like 5/15/2020, you'd use m/d/y for the source
date format. If your dates look like 3-Mar-19, you'd use d-m-y for the source
date format. As long as you tell SMS where to find the dataq, it's smart enough

to determine that Jan, January, and 1 are the same thing.

There are times, of course, where you'll come across date formats that SMS
can't parse on its own. For example, February 20th, 2018 could be stored as
022018. In these situations, you can apply regular expression transformations

to the data before converting it to a date.

Here we:

Start with text like 022018
Convert it to text like 02-20-18

Parse it into a date with m-d-vy

Add Transformation

IF FILTER TYPE REGULAR EXPRESSION

Sale Date matches regular expression... ~ ()0

L THEN TRANSFORM ACTION SUFFIX

1st group in the regular expression ~ by appending... S/

L THEN TRANSFORM ACTION SUFFIX

2nd group in the regular expression ~ by appending... v

L THEN TRANSFORM ACTION SOURCE DATE FORMAT

Sale Date by converting to date... ~ m-d-y

L Add THEN
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Organizations and Templates

New Organization Info dialog

There is a new menu option when editing organizations called Organization

Info.

@® us

@ Latin America New Organization

@ Australasia Edit Templated Copy

@ Africa
Copy W

@ (sales template)

O Operations Recalculate Scores

QO Information Technology Organization Info

O Human Resources
Delete

¥= Expand All

Clicking this opens a dialog showing information about the organization,

including its name, ID, source template, templated copies, etc.

Organization Info

rempilate

Latin America @ (sales template) @

Y

All new templates are for organizations
With the addition of the Charts section and full-featured support for

Organization templating, all new templates must now be created at the

Organization level. Existing item-level templates for Reports, Dashboards, and
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Strategy Maps will continue to work, but you will not be able to create new

item-level templates.

Organization-level templates can do everything item-level templates could do,
and more. Organization-level templates also support more item types, including

Scorecards, Dashboards, Strategy Maps, Charts, and Reports.

Copy “Mobileworld Inc. Example” as a Template...

You may optionally add a prefix or suffix to the name of the new organization and its
scorecard, dashboards, and reports. If you choose to add neither, the new items will
have the same name as the template.

ORGANIZATION NAME

Mobileworld Inc. Example

SCORECARD NAMING

Prefix

Scorecard

DASHBOARD AND STRATEGY MAP NAMING

Prefix Suffix

Dashboard

CHART AND REPORT NAMING

Prefix Suffix

Cancel
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Administration

Configuration settings for missing values

There are now two configuration options in the Administration section for

choosing how you want to treat missing values.

Yes

My Alerts |gnore Gray Scorecard Items For Tree Rollup
Allowed File Types (Leave Blank To Allow All)
USERS & GROUPS Yes 2
Users Ignore Periods Without Values For Time Aggregation
Hide Error Stack Traces
Groups & Permissions Yes -
No
Send Broadcast Alert Default For Missing Value Treatment
T = - Validate Embedded Dashboard Widgets & Briefing Slides
DATA IMPORT & EXPORT reatas blan
Yes
Shared Dashboards Show N/A Option
Scheduled Exports Yes 34
AUTHENTICATION SETTINGS
Imports Scoring Type For Non-KPls
Authentication Type
3 Color -

Import Connections
Spider Impact v

CONFIGURATION Enable Forward Effect Scoring

No Enforce Strong Passwords (Numbers And Letters)

Calendars
No o

Dataset Rollup Trees ivide By Zero Equals Zero

No . Changes Before A Password Can Be Reused

Application Administration
Always allow password reuse -

Server Administration

Force Users To Change Passwords Every Number Of Days

1. "Ignore Gray Scorecard Items For Tree Rollup"” is for missing values when
rolling scores up a scorecard tree. By default, missing values are ignored, which

means that a parent will have a score if at least one of its children has a score.

[ Financial 8 Gross Profit O % A B O ©
Overview KPIs @ Edit November2021 ~ < >
PERFORMANCE HISTORICAL PERFORMANCE 7

5
m 4
(-]
3
-] o
o °
2
o
o o—©
10
3.33 __ .
SCORE % Nov Dec Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov
\ 2020 2020 2021 2021 2021 2021 2021 2021 2021 2021 2021 2021 2021
DATA USED IN CALCULATIONS RELATED ITEMS 4+ Add

© Total Gross Profit

% Gross Profit
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When "Ignore Gray Scorecard Items For Tree Rollup” is off, a single missing KPI

value will cause everything in the tree above it to have no score.

[ Financial Gross Profit 0 * A B & ©

Overview KPis @ Edit November2021 v < >

Not updated for this period

Ope s .
[3) Scorecards .
- - I >rofit . 0

@ i

Nov Dec Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov
2020 2020 2021 2021 2021 2021 2021 2021 2021 2021 2021 2021 2021

© Total Gross Profit / 509
509

% Gross Profit

¥= Expand All

2. "Ignore Periods Without Values For Time Aggregation” is for missing values
over time. By default missing values are ignored, so a larger period is scored
even when not all of the smaller periods are complete. In this example the Total

Gross Profit KPIl does not yet have a value for December 2021.

D Financial Total Gross Profit O * A B & ©
Overview KPIs Edi December2021 v < >
+ New Scorecard item
PERFORMANCE HISTORICAL PERFORMANCE p
oss . $500,000
. Not updated for this period
400,000 O © o ° °—o
$300,000
(=
@ chart 2 $200,000
$100,000
[3) Scorecards
= $422K - $433K w
[ Initiative RED SCORE GOAL Dec Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec
2020 2021 2021 2021 2021 2021 2021 2021 2021 2021 2021 2021 2021
KPI H / + d
Product Revenue o
December 2021 $422K $433K '
L3
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When you change the calendar to Quarter 4, 2021, the Total Gross Profit KPI
has a score for that quarter, even though one of the months in the quarter

doesn't have a value.

{0 Financial Total Gross Profit 0 % A B & ©

Overiiew KPls © ~ Quarter4,2021 ~ < >

+ New Scorecard Item

PE AANCE I RICAL PERFORMANCE v
$1,400,000
$845K B - 0-0-o
$1,000,000
$800,000 o
Total Gross Profit $600,000
O %Gr Sfit . $400,000
3] Scorecards o 8 * $200,000
- o S . $845K 3.33 $866K -
Ll itaive RED SCORE GOAL Q4 @ 02 @3 04 Q1 Q2 @ 04 @ Q2 @ 04
- 2018 2019 2019 2019 2019 2020 202¢ 2020 2020 2021 202 2021 202
A LUES = 7/ TEMS + Ad
Product Revenue -
o
@ October2021 333 $422K $422K $433K
® November 2021 3.33 $422K $422K $433K

December 2021 Q $433K

When "Ignore Periods Without Values For Time Aggregation” is off, Quarter 4,
2021 now has a blank score because not all of the months in the quarter have

values.

Financial Total Gross Profit 0 % A B &6 ©
Overview KPIs Edit Quarter4,2021 v < >
PERFORMANCE HISTORICAL PERFORMANCE 7

$1,400,000
$845K -$432K $1,200,000 0—0—©°
$1,000,000
$800,000
$600,000
$400,000
$200,000
$845K -  $866K w
RED SCOREWE" GOAL Q¢ 01 02 03 04 QL Q2 Q3 04 QL ‘Q?J Q3 Q4
\4
KPI AND THRESHOLD VALUES ’ RELATED ITEMS + Add
Product Revenue .
® October 2021 333 $422K $422K $433K
® November 2021 333 $422K $422K $433K

December 2021 \SHZK $433K X
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New "log in as other users" permission

There's a new permission for Administrator groups called “log in as other users”.
This makes it more obvious who can log in as other users, and it allows large

organizations to set up a more decentralized approach to user management.

New Group: Advanced Permissions Selectdefault  Unselectall
© viEw @ (® RePORTS O ses OTHER @
View All Organizations Madify Reports v Modify Scorecard and Initiative Notes v
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Users will be able to log in as other users if both criteria are met:

1. They are members of a group that has the “"Log in as other users”
permission.

2. They have the same or more permissions as the person they're logging in
as, including viewable organizations, advanced group permission

checkboxes, and dataset permissions.

In other words, logging in as another user will not allow you to see or do

anything that you can't already see or do.

Setting logout time

System administrators can now set the number of minutes of inactivity to

automatically log users out of SMS.

Dataset Rollup Trees Session Timeout Interval (Minutes)
Application Administration 60

Server Administration

Soider Impact Databases
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New permission default for Local Administrators

The "Modify View Organization Permissions” permission now defaults to "On"

for new local administrator groups.

Select default  Unselectall
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[3] SCORECARDS & ORGANIZATIONS
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Modify Owners and Updaters

Modify Scorecard Overview
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Modify All Imperts

Modify Import Connections




Usability

Closing open filter widget doesn't zoom

Users close open filter widgets by clicking on empty dashboard space. This

action no longer zooms in on the dashboard.
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Dashboard widget rotation handle icon

There is now an icon inside of the rotation handle for text and image dashboard

b

widgets.
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Device Sales

This makes it clearer what the rotation handle does.
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Rearranged info dialogs

The list of templated copies can be quite long, so related items are now shown

above them in info dialogs.

Scorecard Info

BASIC INFO
ID Name
1315 Sales
DETAILS

Type sht

Weigh
Scorecard 100%

RELATED ITEMS

COPIES

NAME ORGANIZATION

Sales Sales

Sales (Africa) Africa

Sales (Australasia) Australasia

Better email alert subject lines

The subject lines on all emails have been rewritten to provide more information.
Rather than just saying you've received an alert, they now tell you what kind of
alert you've received.
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Mapping column headers locked while scrolling
The column headers are logged into place when scrolling on data import

mapping.

Mapping

Now it's time to match your source data with the destination KPIs that you've selected. We've
done our best to automatically match them, but be sure to double-check to make sure we got it

ORGANIZATION SCORECARD ITEM IMPORT

Financial Training Revenue

Financial Book Revenue

Financial Product Costs X

Financial Training Venue Costs

Financial Book Production Costs

Financial Total Costs

Financial Total Gross Profit

Cancel

Show buttons without hover

All buttons and controls now show regardless of whether you're hovering your

mouse over them. This increases usability by making all actions easier to

discover.
1
1 l‘ Power Users (Power Users) o
1 " Interactive Users (Interactive Users)\ 1)

l‘ Human Resources (Update Users) o

' Full User 10}
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New upload controls

There are new upload controls used throughout SMS that make it easier to
choose a file. You can either drag a file into the window, or you can click on the

box to open a file chooser.

Import a Spreadsheet

You can pull data from an Excel spreadsheet or a CSV file.
List your field names in separate columns in the first row
Each row after the first will become a distinct record

CSV imports are much faster than Excel

You can import a zip file containing multiple spreadsheets

Choose A Source

& Upload afile

Select AFile

D

Drag & drop new files here
or click to choose a file

Cancel

Other

In addition to many bug fixes, there were several other notable enhancements

in this release, including:

e Replace thumbs up/down icons

e Prevent missing X axis labels

¢ RMF Requirement: Show Successful Logout

e Update "powered by" text on login page

e Don't strip querystring off mailto links

e Slightly reduce the space above chart X axis labels

e Unify "actual value" language
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e Add message explaining when only 100 users or groups are shown

e Change order of dashboard/chart colors

e Import notes column when dates are in header row

e Alert users of failed exports

e AllFTP & Google Sheet imports now share the same Ul

e Change message when only percent weightings need to be calculated

e Support for 2-digit years in date transformations

e Don'tinclude the time and number of results in SQL reports

e Only folders have hover/active states in FTP list

e Don't automatically select a rollup tree in administration

e Alert users earlier that equations on new Link fields requires two steps

e Add data type icons next to all dataset fields

e Replace "breakdown" language

e Form widget input validation

e Form field widget suggested values

e Add Time-Only Toggle Option To Date-Time Filters

e Make form widget interaction clearer in edit mode

e Give users more information about invalid dataset data

e Support more than one record list on a form page

e Hour-Of-Day Rows Option For Dataset Tables

e Change flow for uploading dataset spreadsheet

e Add Time Display Options For Dataset Time and Datetime Fields

e Show dashboard filter drawer in edit mode

e Tooltips for Rebuild Dataset and Fetch New Data

e Split data type menu into two separate selects in Edit Dataset Field
dialog

e Show dataset used to build report or form

e Show related forms in dataset info dialog
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